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Copyright © Tektronix. All rights reserved. 使用許諾ソフトウェア製品は、Tektronix またはその子会社や供給者が
所有するもので、米国著作権法および国際条約の規定によって保護されています。

Tektronix 製品は、登録済および出願中の米国その他の国の特許等により保護されています。 本書の内容は、既に
発行されている他の資料の内容に代わるものです。 また、本製品の仕様および価格は、予告なく変更させていただ
く場合がございますので、予めご了承ください。

TEKTRONIX および TEK は Tektronix, Inc. の登録商標です。

Tektronix 連絡先

Tektronix, Inc.
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

製品情報、代理店、サービス、およびテクニカル・サポート：
北米内：1-800-833-9200 までお電話ください。
世界の他の地域では、www.tektronix.com にアクセスし、お近くの代理店をお探しください。



保証

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証します。
この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の費
用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が使用
する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、または再生
品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包していただ
き、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送される場合に
おいて、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返送費用を負担し
ます。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の費用をお客様に負担し
ていただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障または
損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を負いません。
a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷に対する修理。b）不
適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製ではないサプライ用品の使用
により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品と統合された場合において、改造
または統合の影響により当該本製品のサービスの時間または難度が増加したときの当該本製品に対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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保証

当社では、ソフトウェア製品を提供する目的で使用されているメディア、およびそのメディア上のプログラムのエンコー
ドにおいて、出荷の日から 3 か月間、材料およびその仕上がりについて欠陥がないことを保証します。この保証期
間中にメディアまたはエンコードに欠陥があることが判明した場合、当社では、当該欠陥メディアの交換品を提供し
ます。ソフトウェア製品を提供する目的で使用されているメディアを除き、本ソフトウェア製品は、明示的保証または
暗示的保証を問わず何等保証のない "現状有姿" のまま提供されています。当社では、本ソフトウェア製品に含ま
れる機能がお客様の要求を満たすこと、プログラムの動作が中断されないこと、エラーが発生しないことのいずれも
保証いたしません。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただきます。お客様から通知を受けた後、妥当な期間内に材料およびその仕上がりに欠陥がない交換品を提供
できない場合、お客様は、本ソフトウェア製品のライセンスを終了して本製品とその関連材料を返却し、お客様が既
に支払った代金を払い戻すことができます。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥メディアの交換またはお客様が支払った代金払い戻しを行う当社の責任は、本保証の不履行についてお客様
に提供される唯一の排他的な法的救済となります。間接損害、特別損害、付随的損害または派生損害については、
当社およびそのベンダは、損害の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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重要

機器を操作する前にお読みください

本ソフトウェアは、Tektronix, Inc. からのライセンスに基づき提供されます。本プログラムの保有期間が 30 日を超え
た場合、または方法の如何を問わず本プログラムが使用された場合、お客様は、本ライセンス条項を承諾したものと
みなされます。

同梱のソフトウェア・ライセンス契約書をよくお読みください: 本ライセンス条項にご同意頂けない場合、最寄
りのテクトロニクス営業所までお早めにお問い合わせの上、返品に関する手配をご用命ください。

テクトロニクス・ソフトウェア・ライセンス契約書

機器内に搭載されたプログラムも含む本プログラムは、本契約条項を条件として提供されます。本プログラムの保有
期間が 30 日を超えた場合、または方法の如何を問わず本プログラムが使用された場合、お客様は、本契約条項を
承諾したものとみなされます。これらの条項にご同意頂けない場合、未使用のプログラムおよび関連資料をテクトロ
ニクスへ至急ご返送ください。お支払い頂いたライセンス料金を全額払い戻します。（機器に搭載された本プログラ
ムの返却については、最寄りのテクトロニクス営業所までお問い合わせください。）

定義: 「テクトロニクス」とは、機器を供給している米国オレゴン州法人 Tektronix, Inc. または他の国もしくは地域の
テクトロニクス・グループ法人を意味します。

「プログラム」とは、この契約書に該当するテクトロニクスのソフトウェア製品、またはこの契約書を同梱している機器に
含まれているソフトウェア製品（実行可能なプログラムとデータの一方または両方）を意味します。

「お客様」とは、このプログラムを発注した個人または組織を意味します。

ライセンス: お客様は、次の行為を行うことができます。

1. 一時点で 1 台の機器上でのみ本プログラムを使用すること。

2. 本プログラムがフローティング・ユーザ・ライセンスに基づき提供された場合、正規ユーザが複数台の機器上で本
プログラムを使用すること。ただし、一時点での正規ユーザ総数がライセンスに規定の同時使用ユーザ総数を超
えないことを条件とします。

3. 1 台の機器上で使用することを条件として、本プログラムを改変し、または他のプログラムと併合すること。

4. 保管またはバックアップの目的で本プログラムを複製すること。ただし、かかる複製物がどの時点においても 1 部
を超えて存在しないことを条件とします。本プログラムがフローティング・ユーザ・ライセンスに基づき提供された
場合、正規ユーザが使用することを条件として、複数台の機器上に本プログラムをコピーすることができます。

お客様は、自己が作成した本プログラムの各複製物に対し、テクトロニクスから受領した本プログラムと同一の著作
権表示および権利制限事項を明示する必要があります。

お客様は、次の行為を行うことができません。

1. フローティング・ユーザ・ライセンスまたは別途のサイト・ライセンスに基づく場合を除き、同時に複数台の機器上
で本プログラムを使用すること。

2. テクトロニクスから書面による事前の許可を得ることなく、第三者もしくは外部の組織に対し本プログラムを譲渡す
ること、またはお客様が所属している法人に対し本プログラムを譲渡すること。ただし、本プログラムが搭載されて
いる機器を譲渡する場合を除きます。

3. 管轄権を有する米国または他国政府の法令により輸出または再輸出が制限されている国に対し、必要とされる
場合の米国商務省輸出管理局およびかかる他国政府機関の事前の許可なく、本プログラム、関連資料またはこ
れらの直接的産物を直接または間接的に輸出または再輸出すること。



4. オブジェクトコード形式の本プログラムについて、目的の如何を問わず逆コンパイルまたは逆アセンブルを行うこと。

5. 本プログラムの関連資料を複製すること。

1 台の機器に搭載された本プログラムが他の機器に移転されることなく 1 台以上の他の機器をローカルまたはリモー
トで支援する場合、かかる他の機器は、「1 台の機器」の定義に含まれるものとします。本プログラムを複数の機器に
個別に搭載してそれぞれをローカルで稼動させるという運用形態をとる場合、本プログラムを使用する機器ごとに、
またはフローティング・ユーザ・ライセンスに基づく正規の同時使用ユーザごとに別個のライセンスが必要となります。

本プログラムおよびそのすべての複製物（本プログラムまたはかかる複製物が存在するメディアを除きます）に係る
権利は、テクトロニクスに、またはテクトロニクスが各ライセンス権を取得した第三者に帰属します。

お客様は、本プログラムの保有もしくは使用または本ライセンスについて本契約発効以後に課されるすべての税金
を期限までに支払い、かかる税金につき必要とされるすべての届出を行います。

本プログラムのうちお客様により改変された部分、または他のプログラムと併合された部分に対しても、本契約条項
が適用されます。

本プログラムが米国政府機関により、または当該機関のために取得された場合、本プログラムは、私企業の費用負担
にて開発されたコンピュータ・ソフトウェアとみなされ、本契約におけるライセンス許諾は、調達関係の適用法令にて定
義されるとおり、本プログラムおよび関連資料における制限された権利をお客様に許諾することとして解釈されます。

本契約条項により明示的に許可された場合を除き、お客様は、本プログラムを使用、複製、改変、併合、または第
三者に譲渡することができません。

本プログラムの複製物、改変物、または併合部分が譲渡された場合、本契約において許諾されたライセンスは、自
動的にただちに解約されます。

期間: 本契約において許諾されたライセンスは、お客様が本契約を承諾した時点を以て発効し、本契約の規定に
より解約されるまで有効に存続します。お客様は、テクトロニクスに書面にて通知することにより、本ライセンスをいつ
でも解約することができます。お客様が本契約条項に違反した場合において、テクトロニクスまたはテクトロニクスが
各ライセンス権を取得した第三者からその旨の通知があった日から 30 日以内にかかる違反が是正されなかったと
きは、テクトロニクスまたはかかる第三者は、本ライセンスを解約することができます。本契約の解約後、お客様は、
本プログラムおよび関連資料を、形態の如何を問わずその複製物のすべてと共に、ただちにテクトロニクスに返還
し、または破棄します。

制限保証: テクトロニクスは、本プログラムが提供されたメディアおよび本プログラムのメディアへの記録状態に材
質および製造上の欠陥がないことを、発送後３ヵ月間保証します。当該保証期間中にかかるメディアまたは記録状
態に欠陥があることが判明した場合、テクトロニクスは、欠陥メディアと交換に代替品を提供します。本プログラムが
提供されたメディアに関する場合を除き、本プログラムは、明示または黙示の何等の保証もなく現状のままで提供さ
れます。テクトロニクスは、本プログラムの機能がお客様の要求を満たすこと、および本プログラムに動作の中断また
は誤動作が全くないことについては保証しません。

本保証に基づくサービスを受けるため、お客様は、当該保証期間の満了前に欠陥をテクトロニクスに通知します。そ
の後妥当な期間内にテクトロニクスが材質および製造上の欠陥のない代替品を提供することができなかった場合、
お客様は、かかる本プログラムのライセンスを解約し、本プログラムおよび関連資料を返却して払戻しを受けることが
できます。

本保証は、明示であると黙示であるとを問わず、他の一切の保証に代わって、本プログラムにつきテクトロニクスによ
り行われます。テクトロニクスおよびその販売店は、商品性または特定目的に対する適合性についての一切の黙示
保証を否認します。本保証の違反につきお客様に為される救済は、テクトロニクスが欠陥メディアを交換し、または
お支払済ライセンス料があればその払戻を行うことに限定されます。

責任の制限：　お客様による本プログラムの保有または使用に起因または関係する間接損害、特別損害、付随的損
害、および派生損害については、テクトロニクスおよびテクトロニクスがライセンス権を取得した第三者は、かかる損
害が発生し得る旨の事前通知を受けていた場合といえども、いかなる責任をも負いません。



第三者の免責事項: 別途明示的に合意した場合を除き、テクトロニクスがライセンス権を取得した第三者は、本プ
ログラムにつきいかなる保証も行わず、本プログラムの使用につきいかなる責任も負わず、また、本プログラムに関す
る支援または情報を提供するいかなる義務をも負いません。

一般条項: 本契約書は、本プログラムの使用、複製、及び譲渡に関する当事者間の完全なる合意事項を構成し
ます。

お客様は、テクトロニクスの事前の書面による同意なく、本契約及び本契約において許諾されたライセンスを第三者
に譲渡することができません。

本契約および本契約において許諾されたライセンスは、米国オレゴン州法令に準拠します。

本契約または本契約において許諾されたライセンスにつきご不明な点がございましたら、最寄りのテクトロニクス営
業所までお問い合わせください。

ビデオ・テスト・シーケンスに対する追加ライセンス供与: ソフトウェア製品には何らかのテスト・パターン、ビデ
オ・テスト・シーケンス、およびビデオ・クリップ（合わせて「ビデオ・テスト・シーケンス」）が含まれている場合がありま
す。その場合、ビデオ・テスト・シーケンスに関するお客様の権利は以下の条項のとおりです。

お客様はビデオ・テストの実行に伴い、ビデオ・テスト・シーケンスの使用、複製、改変、ならびに個々のビデオ・テス
ト・シーケンスの表示もしくは複製の配布を行うことができます。

お客様は、以下のいかなる行為についても許諾されていません。

1. お客様はテクトロニクスからの書面による事前の許可を得ることなく、ビデオ・テスト・シーケンスの集合体につい
て、かかるビデオ・テスト・シーケンスを含む元の機器を売却する場合を除き、配布することはできません。

2. お客様は、ビデオ・テスト・シーケンスの第三者による配布を許可することはできません。

3. お客様は、本ビデオ・テスト・シーケンスの複製を単独で販売、ライセンス供与、もしくは配布してはなりません。ま
たかかるビデオ・テスト・シーケンスが製品やサービスの価値の主体をなす場合は、いかなる集合体、製品、サー
ビスの一部としても販売、ライセンス供与、もしくは配布することはできません。

お客様は、お客様によって改変されたビデオ・テスト・シーケンスの使用もしくは配布の結果生じたいかなる申立ても
しくは訴訟（弁護士費用を含む）に対してもテクトロニクスを免責し、補償し、また弁護しなければなりません。

お客様の製品やサービスにかかるビデオ・テスト・シーケンスの複製を含める場合は有効な著作権表示を含めなけ
ればなりません。
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性に
関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があります。
システムの操作に関する警告や注意事項については、他製品のマニュアルにある安全に関するセクション
をお読みください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コードの
みを使用してください。

接続と切断は正しく行ってください。 プローブと検査リードは、電圧ソースに接続されている間は着脱し
ないでください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避けるた
め、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品が正しく接
地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

共通端子を含むどの端子にも、その端子の最大定格を超える電位をかけないでください。

電源を切断してください。 電源コードの取り外しによって主電源が切り離されます。電源コードをさえぎら
ないでください。このコードは常にアクセス可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作させな
いでください。

故障の疑いがあるときは動作させないでください。 本製品に故障の疑いがある場合、資格のあるサー
ビス担当者に検査してもらってください。

露出した回路への接触は避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに
触れないでください。

バッテリの交換を正しく行ってください。 指定されたタイプおよび定格のバッテリと交換してください。

適切なヒューズを使用してください。 本製品用に指定されたタイプおよび定格のヒューズのみを使用し
てください。

保護メガネを着用してください。 高輝度の光線にさらされる場合やレーザー放射が存在する場合は、保
護メガネを着用してください。
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安全にご使用いただくために

湿気の多いところでは動作させないでください。

爆発性のあるガスがある場所では使用しないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュアル
の設置方法を参照してください。
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安全にご使用いただくために

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本製品やその他の接続機器に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

DANGER: ただちに人体や生命に危険をおよぼす可能性があることを示します。

WARNING: 人体や生命に危険をおよぼす可能性があることを示します。

CAUTION: 本製品を含む周辺機器に損傷を与える可能性があることを示します。

本製品では、次の記号を使用します。
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適合性

適合性

このセクションでは、本機器が適合している EMC 基準、安全基準、および環境基準について説明します。

EMC

EC 適合宣言 - EMC

指令 2004/108/EC 電磁環境両立性に適合します。『Official Journal of the European Communities』に記載
の以下の仕様に準拠します。

EN 61326-1:2006、EN 61326-2-1:2006: 測定、制御、および実験用途の電子機器を対象とする EMC
基準。 1 2 3

CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション

IEC 61000-4-2:2001：静電気放電イミュニティ

IEC 61000-4-3:2002：RF 電磁界イミュニティ

IEC 61000-4-4:2004：ファスト・トランジェント／バースト・イミュニティ

IEC 61000-4-5:2001：電源サージ・イミュニティ

IEC 61000-4-6:2003：伝導 RF イミュニティ

IEC 61000-4-11:2004：電圧低下と停電イミュニティ 4

EN 61000-3-2:2006: AC 電源高調波エミッション

EN 61000-3-3:1995: 電圧の変化、変動、およびフリッカ

欧州域内連絡先:
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。

2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。

3 ここに挙げた各種 EMC 規格に確実に準拠するには、高品質なシールドを持つインタフェース・ケーブルが必要です。

4 70%/25 サイクルの電圧低下および 0%/250 サイクル瞬断の各テスト・レベルにおいて、性能基準 C を適用します（IEC
61000-4-11）。

オーストラリア／ニュージーランド適合宣言 - EMC

ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。

CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション（EN 61326-1:2006 に準拠）
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適合性

安全性

EC 適合宣言 - 低電圧指令

『Official Journal of the European Communities』に記載の以下の基準に準拠します。

低電圧指令 2006/95/EC

EN 61010-1:2001：測定、制御および実験用途の電子装置に対する安全基準

米国の国家認定試験機関のリスト

UL61010B-1:2003：初版。測定、制御、および実験用途の電子装置に対する安全基準

カナダ規格

CAN/CSA C22.2 No.1010.1-92：測定、制御、および実験用途の電子装置に対する安全基準

CAN/CSA C22.2 No. 1010.1B 97、CAN/CSA C22.2 No. 1010.1-92（修正条項第 2）：測定、制御、およ
び実験用途の電子装置に対する安全基準

その他の基準に対する適合性

IEC 61010-1:2001：測定、制御、および実験用途の電子装置に対する安全基準

機器の種類

測定機器

安全クラス

クラス 1 - アース付き製品。

汚染度

製品内部およびその周辺で発生する可能性がある汚染の尺度です。通常、製品の内部環境は外部環境と
同じとみなされます。製品は、その製品に指定されている環境でのみ使用してください。

汚染度 1：汚染なし、または乾燥した非導電性の汚染のみが発生します。このカテゴリの製品は、通常、
被包性、密封性のあるものか、クリーン・ルームでの使用を想定したものです。

汚染度 2：通常、乾燥した非導電性の汚染のみが発生します。ただし、結露によって一時的な導電性が
発生することもまれにあります。これは、標準的なオフィスや家庭内の環境に相当します。一時的な結露
は製品非動作時のみ発生します。

汚染度 3：導電性のある汚染、または通常は乾燥して導電性を持たないが結露時に導電性を帯びる汚
染。これは、温度、湿度のいずれも管理されていない屋内環境に相当します。日光や雨、風に対する直
接の曝露からは保護されている領域です。

汚染度 4：導電性のある塵、雨、または雪により持続的な導電性が生じる汚染。これは一般的な屋外環
境に相当します。
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適合性

汚染度

汚染度 2（IEC 61010-1 の定義による）。注：屋内使用のみについての評価です。

過電圧カテゴリ

過電圧カテゴリ（電源入力）

viii MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル



適合性

環境条件について
このセクションでは本製品が環境に及ぼす影響について説明します。

使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル: 本製品の製造には天然資源が使用されています。この製品には、環境または人体に
有害となる可能性のある物質が含まれているため、製品を廃棄する際には適切に処理する必要があります。
有害物質の放出を防ぎ、天然資源の使用を減らすため、機材の大部分を再利用またはリサイクルできる適
切な方法で処理してください。

この記号は、本製品が WEEE（廃棄電気・電子機器）およびバッテリに関する Directive
2002/96/EC および 2006/66/EC に基づき、EU の諸要件に準拠していることを示しています。
リサイクル方法については、Tektronix Web サイト（www.tektronix.com）の「Service & Support」
のセクションを参照してください。

水銀に関するお知らせ: この製品に使用されている LCD バックライト・ランプには、水銀が含まれてい
ます。廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まいの地域
の所轄官庁にお尋ねください。

過塩素酸塩材: 本製品には 1 つまたは複数の CR 型リチウム電池が搭載されています。CR 型リチウム電
池はカリフォルニア州法により過塩素酸塩材として規定され、特別な取り扱いが求められています。詳細に
ついては、www.dtsc.ca.gov/hazardouswaste/perchlorate を参照してください。

有害物質に関する規制

本製品は Monitoring and Control（監視および制御）装置に分類されており、2002/95/EC RoHS Directive
（電気・電子機器含有特定危険物質使用制限指令）の適用範囲外です。
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まえがき

まえがき

このマニュアルでは、当社の MTS400 シリーズ MPEG テスト・システムの機能と使用方法について説明しま
す。このマニュアルでは、次の規則に従って製品名を表します。

MTS400 シリーズ・システム： MTS415 型、MTS430 型および MTS4SA 型を表します。

MTS415 型システム：MTS415 型のみを表します。

MTS430 型システム：MTS430型のみを表します。

MTS4SA 型スタンドアロン・システム：MTS4SA 型のみを表します。

MTS400P 型システム：MTS400P 型のみを表します。

このマニュアルでは MTS400P 型の操作方法については説明していません。操作に関しては、『MTS400P
型クイック・スタート・ユーザ・マニュアル』（当社部品番号 071-2611-XX）を参照してください。

MTX100B 型／RTX100B 型／RTX130B 型：それぞれ、MTX100B 型 MPEG レコーダ＆プレーヤ、
RTX100B 型 ISDB-T RF 信号ゼネレータ、および RTX130B 型 QAM ＆ VSB RF 信号ゼネレータのみを
表します。

主な特長
MPEG、DVB、ATSC、ISDB、および ISDB-TB（ブラジル）などの広範囲の DTV 規格をサポートしていま
す。これらの規格の地上波、ケーブル、衛星、および地域別の放送方式に特定の SI が対応します。

さまざまなインタフェースと解析機能により、RF または IP レイヤ・トランスミッション・リンクやトランスポー
ト・ストリーム・コンテンツ処理など、あらゆるネットワーク環境で発生する問題を診断するために必要な
接続が実現します。

クロスレイヤ障害解析やログ機能が内蔵されているため、1 つの機器で障害診断を行うことができ、トラ
ブルシューティング時の調査にかかる時間を短縮できます。

再生機能を用いれば、IP マルチセッションのレプリケーションをシミュレートすることで、被測定ネットワー
クや被測定デバイスの動作を評価できます。

CaptureVu™ テクノロジにより、リアル・タイムおよびオフラインでシステム・イベントの取り込みと解析がで
きます。

革新的でプログラム中心のユーザ・インタフェースによって、経験の長短を問わず、誰でも専門家並み
の判断を下すことができます。

多重ストリームおよびエレメンタリ・ストリームのコンプライアンスをチェックする H.264 バッファ解析では、
H.264 コンテンツが含まれるトランスポート・ストリームの作成と解析に使用できる強力なツール群が提供
されます。

Tclips MPEG テスト・ストリーム
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マニュアル
このマニュアルでは、MTS400 シリーズ・システムの設置と基本的な操作方法について説明します。また、こ
の製品には以下のマニュアルがあります。

項目 目的 参照先

MTS400 シリーズ・クイック・
スタート・ユーザ・マニュアル
（071-2607-XX 英語、
071-2608-XX 日本語）

テスト・システムの設置方
法および使用方法の概要
を説明します。

MTS400 シリーズ・アナライザ・
アプリケーション・ユーザ・マ
ニュアル（077-0205-XX）

TSCA、PES アナライザ、
T-STD バッファ・アナライ
ザ、および ES アナライザ
の各アナライザ・アプリケー
ションに関する操作方法を
説明します。

MTS400 シリーズ・ゼネレー
タ・アプリケーション・ユーザ・
マニュアル（077-0204-XX）

マルチプレクサ、MPEG
Player、TS エディタ、Make
Seamless Wizard、トランス
ポート・ストリーム・カッタ、
およびスクリプト･パッドの各
ゼネレータ・アプリケーショ
ンに関する操作方法を説
明します。

MTS400 シリーズ・カルーセ
ル・アプリケーション・ユーザ・
マニュアル（077-0203-XX）

カルーセル・アナライザお
よびカルーセル・ゼネレー
タ・アプリケーションの操作
について説明します。

MTS400 シリーズ・プログラマ・
マニュアル（077-0206-XX）

MPEG Player アプリケー
ションの制御用プログラマ・
コマンドについて説明しま
す。

MTS400 シリーズ・リリース・
ノート（077-0200-XX）

テスト・システムに関する既
知の問題について説明し
ます。

MTS4EA 型圧縮ビデオ・エ
レメンタリ・ストリーム・アナ
ライザ・ユーザ・マニュアル
（071-1641-XX）

MTS4EA 型アプリケーショ
ン・ソフトウェアの操作方法
を説明します。

MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル xi
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項目 目的 参照先

MTS4CC 型エレメンタリ・ス
トリーム・コンプライアンス・
チェッカ・ユーザ・マニュアル
（071-2075-XX）

MTS4CC 型アプリケーショ
ン・ソフトウェアの操作方法
を説明します。

ユーザ・マニュアルは Tektronix Web サイト（www.tektronix.com/manuals）からダウンロードできます。

次の URL を使用すると、次の標準機関のホームページにアクセスできます（一覧にある URL はこのマニュ
アルの作成時点で有効な URL です）。

MPEG-2 規格（国際標準化機構）- www.iso.org/

DVB 標準（欧州電気通信標準化機構）– www.etsi.org/

ATSC 標準（高画質テレビ・システム委員会）- www.atsc.org/

このマニュアルの表記規則
このマニュアルでは、次のようなマークが使用されています。

手順番号 フロント・パ
ネルの電源

電源の接続 ネットワーク PS2 SVGA USB

xii MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル
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設置の前に
機器を受け取ったら、次の手順で検査を実行してください。

1. 輸送用段ボール箱に、機器破損の可能性を示す外部損傷がないかどうかを検査します。

2. 輸送用段ボール箱から MTS400 シリーズの機器を取り出します。

3. 輸送中に機器に損傷がなかったかどうかを調べます。機器の外側に傷や衝撃の痕跡がないことを確認
してください。出荷に先立ち、機器は機械的損傷の有無を徹底的に検査されています。

注： 輸送が必要になった場合に機器を再梱包できるように、段ボール箱や梱包材は保管しておいてくださ
い。 (76 ページ 「輸送用の再梱包」 参照)。

4. 標準アクセサリおよびご注文のオプショナル・アクセサリがすべて届いていることを確かめてください。
(71 ページ 「アクセサリ」 参照)。

5. 機器の設置後に、機能チェックの手順を実行します。機能チェック手順については、『MTS400 シリーズ
MPEG テスト・システム仕様および性能検査に関するテクニカル・リファレンス』マニュアルを参照してくだ
さい。

動作条件
以下の表は、MTS400 シリーズ・システムの動作電源要件を示しています。MTS400 シリーズ機器の動作電
源要件の詳細については、『MTS400 シリーズ MPEG テスト・システム仕様および性能検査に関するテクニ
カル・リファレンス』を参照してください。

表 1: 電源動作の要件

要件 仕様

動作温度 + 5 ℃ ～ + 40 ℃

動作高度 0 ～ 3,000 m（9,800 フィート）

電源電圧 100 ～ 240 VAC ≥ 10%（90 ～ 264 VAC RMS）

周波数レンジ 50/60 Hz

最大消費電力 4 A

突入サージ電流 13 A（240 VAC/50 Hz）

4.8 A（ピーク時 100 VAC/60 Hz）

ヒューズ定格 T6.3AH/250 V、高速、オペレータによる交換不可。資格のあるサービス
担当者へ依頼すること。

過電圧カテゴリ II（IEC61010-1 の定義に基づく）

汚染度 2（IEC61010-1 の定義に基づく）。評価対象は屋内用途のみ

MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル 1
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本機器への接続
このセクションでは、MTS400 シリーズ・システムの機器の設置方法について説明します。解析機能（有効な
場合）は、電源を供給し、機器のハード・ディスク上でトランスポート・ストリームを利用できるようにするだけ
で使用できます。監視およびリアルタイム解析機能は同様に電源を必要としますが、外部トランスポート・ス
トリームへの接続も必要となります。

MTS400 シリーズ・システムおよび MTX100B 型／RTX100B 型／RTX130B 型の各機器は、購入時にご注文
いただいたソフトウェアおよびハードウェア・オプションで構成されています。MTS400 シリーズ・システムの
オプションは、当社のアップグレード・キットを使用して追加できます。

注意： MTS400 シリーズ・システムの機器は垂直にして使用しないでください。垂直方向に配置して使用す
ると、ユニットの後部に十分な通気またはケーブル用スペースを確保できません。

過熱による装置の損傷を防ぐために、装置をベンチ上に配置するときは、装置キャビネットの後部および両
側面に少なくとも 2 インチ（5.1 cm）のスペースを確保してください。

2 MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル
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リア・パネル・コネクタ

このセクションでは、標準的な電気接続、信号接続、およびネットワーク接続について説明します。

注意： その他の接続がすべて行われるまで、装置に電源を供給しないでください。

次の図は、MTS400 シリーズ・システムのリア・パネル・コネクタを示しています。

図 1: MTS400 シリーズのリア・パネル

次の表に、トランスポート・ストリーム、ネットワーク、および周辺装置のコネクタの仕様を示します。各コネクタ
および信号の入出力フォーマットの詳細については、『MTS400 シリーズ MPEG テスト・システム仕様および
性能検査のテクニカル・リファレンス』を参照してください。

注意： リア・パネルの図は参考情報です。以下の点にご注意ください。

- GbE Video over IP インタフェース・カードを使用する場合は、スロット 2 に挿入してください。

- IP Video over IP インタフェース・カードまたは RF インタフェース・カードを使用する場合は、スロット 4 に
挿入してください。

- 上記の 2 種類の IP インタフェース・カードは、一度にどちらか一方しか挿入できません。

MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル 3
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表 2: MTS400 シリーズ・システムのリア・パネル・コネクタ

図の参照
番号 説明 コネクタ・タイプ

1 AC メイン電源 -

2 ギガビット・イーサネット（GbE）Video over IP
インタフェース・カード（オプション）

-

3 SFP（Small Format Pluggable）ポート 1 ～ 4 -

4 IP Video GbE インタフェース・カード（オプショ
ン）

-

5 SFP（Small Format Pluggable）

6 イーサネット RJ45

7 ASI/SMPTE 入力 75 Ω BNC

8 ASI/SMPTE 出力 75 Ω BNC

9 RF インタフェース・カード（オプション、図は
8VSB）

-

10 ASI/SMPTE 入力 75 Ω BNC

11 ASI/SMPTE 出力 75 Ω BNC

12 RF 入力 -

13 LVDS/ASI/SMPTE310 （A170 カード） -

14 ASI/SMPTE 出力 75 Ω BNC

15 ASI/SMPTE 入力 75 Ω BNC

16 DVB/SPI 出力 25 ピン、D タイプ・コネクタ

17 メイン入力／出力 （A12 カード）

18 基準クロック入力 50 Ω BNC コネクタ

19 外部トリガ 50 Ω BNC コネクタ

20 DVB/SPI 25 ピン、D タイプ

21 USB コネクタ・パネル -

22 USB 2.0、ソフトウェア・キー（USB オプション）
の取り付け位置

USB 2.0 標準-A ソケット x 2

23 入力／出力カード -

24 ビデオ出力 15 ピン、D タイプ

25 イーサネット 10 Base-T/100 Base-T、RJ45 コネクタ

ギガビット

26 SBC （Single Board Computer） 9 ピン、D タイプ

27 パラレル・ポート、ソフトウェア・キー（パラレ
ル・オプション）の取り付け位置

25 ピン、D タイプ

28 キーボード 6 ピン、ミニ DIN（PS2 互換キーボード）

29 マウス 6 ピン、ミニ DIN（PS2 互換マウス）

4 MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル
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図の参照
番号 説明 コネクタ・タイプ

30 SCSI（工場取り付けのターミネータを含む） SCSI バスの終端

31 RS-232 COM（シリアル）ポート 1 9 ピン、D タイプ

適切なリア・パネル・コネクタにキーボードを接続します。キーボードにはケーブルの終端に 2 つのコネクタ
があります。1 つはキーボード用のコネクタで、もう 1 つはトラック・パッド用のコネクタです。リア・パネルの
図を参照してください。 (図 1 参照)。

ソフトウェア・キーが取り付けられていることを確認します。パラレル・ポート・ソフトウェア・キーを使用する場
合は、取り付けネジを 4 インチポンドのトルク（45 ニュートン・センチメートル）で締め付けてください。

注意： 静電気放電による機器の損傷を防ぐために、機器を操作する前にパラレル・ポート・ソフトウェア・キー
の取り付けネジが正しく締め付けられていることを確認してください。

注： MTS400 シリーズ・システムのアプリケーションは、ソフトウェア・キーが取り付けられていないと動作し
ません。ソフトウェア・キーは取り外さないでください。

ソフトウェア・キーが取り付けられた状態でパラレル・ポートを使用するには、パラレル・ポート・ケーブル（プリ
ンタ・ケーブルなど）をソフトウェア・キーに直接取り付けます。ソフトウェア・キーによってパラレル通信が阻
害されることはありません。

注： アップグレードまたは修理のためにテスト・システムを当社サービス受付センターに返送する場合は、
ソフトウェア・キーを取り外さないでください。

MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル 5
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RF インタフェース・カード・コネクタ

MTS400 シリーズ・システムでは、オプションの RF インタフェース・カードをスロット 5 に取り付けることがで
きます。(図 1 参照)。

コネクタ コネクタ 説明

COFDM RF インタフェース

ASI/SMPTE 入力／出
力

75 Ω BNC 標準 ASI / SMPTE310M 準拠

RF 入力 F タイプ RF 入力

8PSK RF インタフェース 1

ASI/SMPTE 入力／出
力

75 Ω BNC 標準 ASI / SMPTE310M 準拠

RF 入力 F タイプ RF 入力

QAM（Annex B）RF インタフェース

ASI/SMPTE 入力／出
力

75 Ω BNC 標準 ASI / SMPTE310M 準拠

RF 入力 F タイプ RF 入力

8VSB RF インタフェース

ASI/SMPTE 入力／出
力

75 Ω BNC 標準 ASI / SMPTE310M 準拠

RF 入力 F タイプ RF 入力

1 8PSK RF インタフェース・カードには、LNB（低ノイズ・ブロック）LED インジケータが付いています。LNB がアクティブなとき
は LED が点灯します。

各RF カードの In Lock LED は、チャンネルが完全にロックし、信号を正しく受信していることを示します。

各 RF カードでは、ASI/SMPTE 入力コネクタが ASI/SMPTE 出力コネクタにループ・スルーされます。RF
カードを使用する場合は、RF カード ASI/SMPTE 出力が、A170（LVDS/ASI/SMPTE310）カード ASI/SMPTE
入力に接続されていなければなりません。これにより、全測定を行うことが可能になります。

衛星フィードなどの RF入力は、RF カードの RF入力コネクタに接続します。また、同時に使用するASI/SMPTE
入力については、RF カードの ASI 入力に接続します。監視および解析の対象となる入力は、トランスポー
ト・ストリーム・コンプライアンス・アナライザを開いたときに選択した入力の設定によって異なります。『MTS400
シリーズ・アナライザ・アプリケーション・ユーザ・マニュアル』を参照してください。

6 MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル
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GbE インタフェース・カード・コネクタ

IP インタフェース・オプションには、IP ビデオ・ギガビット・イーサネット・インタフェース（IP ビデオ・インタ
フェース）と GigE Video over IP インタフェース（GigE インタフェース）の 2 種類があります。一般に、これら
は GbE インタフェース・カードと呼ばれています。IP ビデオ・インタフェース・カードはスロット 4 に、GigE イ
ンタフェース・カードはスロット 2 に挿入して使用してください。 (図 1 参照)。

GbE インタフェース・カードには、最大 4 つの SFP（Small Format Pluggable）モジュールが用意されており、こ
れによりイーサネット光および銅線の相互接続が可能です。SFP モジュールは、さまざまな波長でのイーサ
ネット光相互接続を可能とします。SFP ポートには、1 ～ 4 まで（カード上部から）番号が付けられています。

次の図は、SFP モジュールと光ポート・プラグを示しています。オプションの一覧には、SFP モジュールのオ
プションが示されています。 (71 ページ 「スタンダード・アクセサリ」 参照)。

GigE インタフェース・カードは、当社にご注文いただいた SFP モジュールで使用可能なことが確認されてい
ます。当社以外の業者から購入した SFP モジュールとの動作は保証されていません。

警告： 有害なレーザー光線にさらされるのを避けるため、米国の連邦規制 CDRH 21 CFR 1040 および
IEC/EN 60825/A2:2001 で規定されているように、Class 1 レーザーのみを使用してください。

注： ケーブルを接続していないときは、SFP モジュールに光ポート・プラグを必ず取り付けてください。

MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル 7
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MTS4USB 型の設置
MTS415 型または MTS430 型システムと併せてオプション MTS4USB 型をご注文いただいた場合、機器と一
緒に USB ドングルも送られています。USB ドングルを PC に取り付けると、MTS400 シリーズのさまざまなソフ
トウェア・オプションが利用できます。利用できるオプションは、ES 型または TS 型のどちらの USB ソフトウェ
ア・オプションを購入したかによって異なります。オプション ES 型では、MTS4CC ソフトウェア・アプリケーショ
ン（MTS415 型システム）または MTS4EA ソフトウェア・アプリケーション（MTS430 型システム）が利用できま
す。オプション TS 型では、TSCA、マルチプレクサ、およびバッファ・アナライザなどの MTS400 シリーズのソ
フトウェア・アプリケーションが利用できます。

オプション MTS4USB 型を取り付けるには、MTS4USB 型ドングルを使用して、「MTS4SA 型スタンドアロン・
システムのインストール」で説明されている手順を実行します。 (8 ページ参照)。

MTS4SA 型スタンドアローン・システムのインストール
MTS4SA 型スタンドアロン・システムは、MTS400 シリーズ・システムのアプリケーション（リアル・タイム機能を
除く）を PC 上で使用できるようにします。詳しい仕様は『MTS400 シリーズ・システム・テクニカル・リファレン
ス』に記載されています。

プション MTS4EA 型（MTS4EA 圧縮ビデオ ES アナライザ）を購入した場合は、付属のユーザ・マニュアル
（『MTS4EA 型圧縮ビデオ ES アナライザ・ユーザ・マニュアル』、071-1641-xx）に記載のインストール手順
に従います。

システム要件

MTS4SA 型スタンドアローン・システムのインストールには、次の最小 PC 構成が推奨されます。

Microsoft Windows™ 2000 あるいは Windows XP オペレーティング・システム

プロセッサ速度 >1.0 GHz

256 MB 以上の RAM

1024x768 以上の画面解像度

120 MB 以上のハード・ディスク容量

注： MTS4EA MPEG 圧縮ビデオ ES アナライザ・アプリケーションは、上記の仕様の PC で十分に動作しま
す。ただし、リソースを集中的に使用する一部の操作は、より強力な PC を使用するとさらに快適に動作しま
す。詳細については、『MPEG 圧縮ビデオ ES アナライザ・ユーザ・マニュアル』を参照してください。
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インストール手順

1. PC の電源を入れ、スタートアップ・
プロセスが終了していることを確認
してください。

2. ソフトウェア・キー（ドングル）が PC
に取り付けられていることを確認し
ます。

3. MTS400 シリーズ・アプリケーション・
ソフトウェア・メディア（CD-ROM ま
たは USB フラッシュ・ドライブ）を PC
の適切なドライブ・スロットに挿入し
ます。

Removable Disk ダイアログ･ボックス
が表示されます。

4. Install Tektronix MPEG Application
Suite をハイライトして、OK を選択
します。

インストール・プログラムが開始さ
れ、Welcome という画面が表示され
ます。

（インストール・プログラムが自動的
に開始しない場合は、Windows エク
スプローラで MTS400 シリーズ・ア
プリケーション・ソフトウェア・メディア
の setup.exe というファイルを検索し
て実行します。）

5. インストールの Welcome 画面で、
Next を選択します。
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6. Setup Type 画面で、Standalone を
ハイライトして Next を選択します。

7. Ready to Install 画面で、Install を選
択します。

注： インストールの途中、メッセージ・ボックスが何回か表示されますが、通常、ユーザの操作は必要ありま
せん。
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8. イ ン ス ト ー ル 時 に 検 出 さ れ た
MTS400 シリーズ・ソフトウェアの旧
バージョンは自動的にアンインス
トールされます。

以前の MTS400 シリーズのバージョ
ンによっては、再起動が必要な場合
があります。この段階でアプリケー
ション・ソフトウェアのメディアを取り
外さないでください。

再起動が必要な場合は、再起動が
完了すると Ready to Install 画面が
再度表示されます。

9. そのままインストールを進めます。

10.事前に WinPcap がインストールされ
ていない場合は、メッセージ・ボック
スで OK を選択して WinPcap のイ
ンストール・プロセスに進みます。

正しいバージョンの WinPcap がイン
ストール済みであることが確認され
た場合、WinPcap を強制的に再イン
ストールするか MTS400 シリーズの
インストールに進むかを選択するこ
とができます。
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11.WinPcap の再インストールを中止し
て MTS400 シリーズ・ソフトウェアの
インストールに進むには、Cancel を
選択します。

OK を選択すると、WinPcap プログ
ラムを上書きして、インストールが進
みます。

注： MTS4SA 型スタンドアローン・システムのインストールの平均時間は約 5 分です。

12. インストールが完了すると、Install-
Shield Wizard Complete 画面が表示
されます。

13.PC を再起動するオプションを選択し
て Finish を選択します。PC がシャッ
トダウンし、再起動します。
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14.PC が再起動したら、Start > Program
> Tektronix MTS400 > OptionKey
Wizard を選択して MTS400 Series
Option Key Wizard を起動します。

15.Tektronix Option Update ダイアロ
グ･ボックスで、インストレーション・マ
ニュアルと共に提供されたオプショ
ン･キー文字列を Key String フィー
ルドに入力します。

16.Apply をクリックします。

17.ライセンス・オプションのリストを調べ
て確認します。

注： 各機能の使用は、ソフトウェア・キーで使用可能なライセンスによって制御されます。アプリケーション
および機能は、インストールは可能ですが、適切なライセンスが取得されるまで使用できません。以上の内
容は、製品または追加ライセンスを購入するときに通知されます。

18.Option Key Wizard を閉じます。

19.これでライセンス供与されたMTS400
シリーズ・スタンドアロン・アプリ
ケーションが、Windows の Start メ
ニューで使用できるようになりまし
た。 (26 ページ 「アプリケーションの
起動」 参照)。
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機器の電源をオンにする

電源の供給

MTS400 シリーズ・システムおよび MTS430 型ユニットは、1 本の導体がアースまたはアース近傍の電位（中
性線）を持つ単相電源で動作するように設計されています。フェイズ・ツー・フェイズや多相システムなど、2
本の通電導体が接地に対して通電状態の電源はお勧めできません。安全な操作のためには、電源コード
内の導体を接地することによる保安用アース接続が必要です。

MTS400 シリーズ・システムを設置して信号および周辺装置の接続が完了したら、電源コードをメイン電源
に差し込みます。 (図 1 参照)。

初回の電源オン

テスト・システムの電源は次のようにしてオンにします。

1. フロント・パネルの On/Standby ス
イッチを押して、機器の電源をオン
にします。

2. 電源投入時のセルフテストが完了
するまで待ちます。

3. 起動時に、システムから Windows
XP をセットアップするよう求められ
ます。必要に応じてデフォルト設定
をそのまま使用し、画面に表示され
る手順に従います。

4. プロンプトが表示されたら、システム
の再起動を許可します。

注： 後でパスワードを設定する場合は、Windows のドキュメントを参照してください。

機器の電源をオフにする
必ず Windows XP のシャットダウン・プロセス（Start > Shut down… または Start > Turn off computer を選択）
によって電源をオフにしてください。システム（アプリケーションを含む）が自動的にシャット・ダウンします。
メッセージが表示されたら、フロント・パネルの On/Standby スイッチを押して機器の電源をオフにします。

または、フロント・パネルの On/Standby スイッチを 2 秒間押してから離します。以上の操作でシステムは自
動的にシャット・ダウンし、電源がオフになります。
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VLC メディア・プレーヤのインストール
トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）でビデオを見られるようにするには、VideoLAN
の Web サイトから最新バージョンの VLC メディア・プレーヤをダウンロードしてインストールする必要があり
ます。

1. MTS400 シリーズ機器またはイン
ターネットにアクセスできる PC を
使用して、VideoLan の Web ページ
（http://www.videolan.org）に移動し
ます。

2. Windows 自己解凍形式の VLC メ
ディア・プレーヤ・インストーラを探
して PC のハード・ディスクにダウン
ロードします。

3. 機器上にダウンロードされた VLC
メディア・プレーヤ・ファイルを探し
て実行します。

4. 使用する言語を選択します。Wel-
come / Setup スクリーンが表示され
ます。

5. セットアップ手順に従って、VLC メ
ディア・プレーヤをインストールしま
す。

これで、必要な作業が終了しました。VLC Media Player は必要に応じて TSCA アプリケーションから使用さ
れます。

MTX100B 型／RTX100B 型／RTX130B 型と VLC Media Player

VLC Media Player を MTS400 シリーズまたは MTX100B 型／RTX100B 型／RTX130B 型にインストールした
場合は、メディア・プレーヤのオーディオ機能を無効にする必要があります。

オーディオ機能を無効にするには、VLC Media Player で以下のステップを行います。

1. Settings > Preferences を選択します。

2. Preferences ダイアログ・ボックスの左側にあるリストから Audio を選択します。

3. General audio settings で、Enable audio チェック・ボックスをオフにします。

4. Save ボタンをクリックし、変更を確定して Preferences ダイアログ・ボックスを閉じます。
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ネットワーク構成
MTS400 シリーズ・システムは、コンピュータ・ネットワークに接続できます。正しいネットワーク設定の詳細に
ついては、ネットワーク管理者に問い合わせてください。インストールおよび操作手順については、ネットワー
ク・ハードウェアおよびソフトウェアに付属のドキュメントを参照してください。

ネットワークのトラブルシューティング

ネットワークは各種規格に基づいていますが、各ネットワーク（LAN または WAN）には固有の特性が多数
存在するため、特定のネットワークに関する十分な知識がないとトラブルシューティングは困難になります。
そのため、ネットワークの詳細なトラブルシューティングは、そのネットワークの特性に精通している専門家
が実行すべきです。

このセクションでは、ネットワーク・エラーの一般的ないくつかの原因を解消できる基本的な手順を紹介しま
す。これらの手順を使用しても問題を解決できない場合は、ネットワーク管理者にお問い合わせください。

基本的な要件

ホスト・マシンのトラブルシューティングを行う前に、次の要件が満たされるようにしてください。

ネットワーク・アダプタ・カードの付属マニュアルの説明に従い、システムをネットワーク上で使用できるよ
うに設定します。詳細については、ネットワーク管理者にお問い合わせください。

テスト・システムの購入後にインストールしたアプリケーションの中に、テスト・システム・コンポーネントに
割り当てられたポートを使用しているものがないかを確認します。

IP パラメータ

このセクションでは、各 IP パラメータ（IP アドレス、サブネット・マスク、およびデフォルト・ゲートウェイ）がネッ
トワーク接続に及ぼす悪影響を図で説明します。

IP アドレスが正しくない: テスト・システムの IP アドレスが正しくない（固有でない）場合は、ネットワーク
上で通信できない可能性があります。次の図では、TVTest_1 が Rennes と同じ IP アドレスを使用していま
す。Rennes が最初に起動されると、TVTest_1 は IP アドレスの競合を認識し、TCP/IP をロードしません。こ
の結果、ネットワーク経由でシステムに到達できません。

IP アドレスが正しくなく、サブネット上に存在しない場合でも、デバイス（システムまたは監視ステーション）か
らの通信は可能な場合がありますが、デバイスへの通信は不可能になる場合があります。

16 MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル



設置 

サブネット・マスクが正しくない: サブネットやサブネットを含むネットワークは複雑であり、IP アドレス指
定についての十分な知識を必要とします。発生しているネットワークの問題にサブネットが関係していると思
われる場合は、ネットワーク管理者にお問い合わせください。次の図は、単純な（比較的よく見られる）サブ
ネット・マスクの問題を示しています。

図の TVTest_1 のサブネット・マスクは、ネットワーク・アドレスが IP アドレスの最初の 2 バイトに含まれている
ことを示しています。ドット区切りの 10 進表記では、ネットワーク・アドレスは 128.181 です。この情報により、
デバイスはデフォルト・ゲートウェイ経由でルーティングされなくても、同じネットワーク・アドレスを持つ他の
デバイスと通信できます。

TVTest_1 は Carnac とは通信できません。これは、TVTest_1 のサブネット・マスクによると、Carnac と TVTest_1
が論理的に同じネットワーク上に存在するためです。この結果、TVTest_1 から Carnac に送信されたメッセー
ジはルーティングされなくなります。この 2 つのデバイスが接続を共有していないため、TVTest_1 は Carnac
のネットワーク・カードの正しいアドレスを見つけることができず、Carnac には到達できません。

TVTest_1 は、TVTest_2 および Rennes とは通信できます。それは、これら 3 つのデバイスが接続を共有し
ているため、TVTest_1 からのメッセージをルーティングする必要がないためです。したがって、正しくないサ
ブネット・マスクが設定されているにもかかわらず、TVTest_1 は TVTest_2 および Rennes の正しいアドレスを
見つけることができます。
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デフォルト・ゲートウェイの IP アドレスが正しくない: TCP/IP Properties ダイアログ・ボックスで指定し
たデフォルト・ゲートウェイは、ネットワーク上の各サブネットワークを "認識している" デバイスです。メッセー
ジ（たとえば、あるシステムから他のサブネット上のデバイスへのトラップ）を送信する場合、デフォルト・ゲー
トウェイはそのメッセージを適切なサブネットにルーティングできます。TCP/IP Properties ダイアログ・ボック
スで指定した IP アドレスが間違っていると、他のサブネット上のデバイスへのメッセージは（デフォルト・ゲー
トウェイまで届かないため）宛先には到達しません。
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一般的なトラブルシューティング手順

以降のセクションで実行する手順の多くは、一般的な作業です。

ホスト・マシンへの Ping: すべての TCP/IP インストールで提供されているユーティリティの 1 つが ping.exe
です（C：\windows\system32\ ディレクトリを探してください）。このユーティリティでは、ホスト・マシンに通信
パケットを送信し、そのマシンからの応答を記録できます。この操作により、パケットが宛先に到達したかどう
かが判別されます。Ping を実行するには、次の手順を使用します。

1. Start メニューから Run を選択しま
す。Run ダイアログ・ボックスが表示
されます。

2. Run のテキスト・ボックスに、次のい
ずれかを入力します。

ping machineName

ping IPaddress

この例では、machineName と IPad-
dress がそれぞれ、ping しようとして
いるネットワーク・デバイスのホスト・
マシン名と IP アドレスを表していま
す。

3. OK をクリックします。

DOS ウィンドウに、マシンが ping に
応答しているかどうかが示されます。
この図では、宛先マシン（Oxford4）
は応答していません。

Ping は短時間だけ実行され、プロ
セスが完了すると DOS ウィンドウは
閉じられます。
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TCP/IP パケットのルートのトレース: パケットが、宛先マシンまでの経路のどこまで到達したかや、その
途中でパケットがどのデバイスを通過したかがわかると便利な場合があります。この機能を提供するユーティ
リティが tracert.exe です。tracert は、ネットワーク内の混雑したポイントを示すこともできます。tracert を実
行するには、次の手順を使用します。

1. Start メニューから Run を選択しま
す。Run ダイアログ・ボックスが表示
されます。

2. Run のテキスト・ボックスに、次のい
ずれかを入力します。

tracert machineName

tracert IPaddress

この例では、machineName と IPad-
dress がそれぞれ、到達しようとして
いるネットワーク・デバイスのホスト・
マシン名と IP アドレスを表していま
す。

3. OK をクリックします。

DOS ウィンドウは、パケットの進行
状況を示しています。右端の列は、
tracert パケットを正常に通したネッ
トワーク上のノードの IP アドレスを
示しています。この情報は、宛先デ
バイスまでの経路上にある最後の
正常なノードを示しています。
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ネットワーク上にあるデバイスの IP アドレスの検索: ネットワーク上にあるコンピュータの IP アドレス
（または、IP アドレスがわかっている場合はネットワーク名）の検索や確認が必要になる場合があります。この
情報が得られると、Hosts ファイルで使用している IP アドレスやネットワーク名が正しいかどうかを確認できま
す。この情報を表示するユーティリティが nslookup.exe です。nslookup は下に説明する方法で使用します。

1. Start メニューから Run を選択しま
す。Run ダイアログ・ボックスが表示
されます。

2. 次のいずれかを入力して Enter キー
を押します。ここで、machineName と
IPaddress がそれぞれ、検索しようと
しているデバイスのネットワーク名と
IP アドレスです。

nslookup machineName

nslookup IPaddress

目的のデバイスのネットワーク名と
IP アドレスが表示されます。ネット
ワークで DNS を使用している場合
は、DNS サーバの IP アドレスとネッ
トワーク名も表示されます。

ネットワーク情報の入手先

ネットワークのトラブルシューティングに関してさらに多くの情報が必要な場合、次のリソースが役立つ可能
性があります。

注： これらのリソースではより多くの情報が提供されている可能性があります。これらの情報の大部分はそ
のまま提供されており、その適合性については、書面または黙示を問わず保証されていません。ネットワー
クに関するトラブルシューティング情報の最善の入手先は、担当のネットワーク管理者です。

Cisco Systems, Inc. – http://www.cisco.com/

このサイトは特に、Cisco 製デバイスを使用しているネットワークに役立ちます

Dulaney, E、Lawrence, S、Scrimger, R、Tilke, A、White, J、Williams, R、Wolford, K 著、『MCSE Training
Guide:TCP/IP』。Indianapolis, IN. New Riders, 1998

これは、MCSE（マイクロソフト認定システムエンジニア）資格のためのトレーニング・ガイドで、TCP/IP と
ネットワークのトラブルシューティングを扱っています。

Taylor, E.著、『Network Troubleshooting Handbook』New York, NY.McGraw-Hill, 1999
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製品の説明
MTS400 シリーズの MPEG テスト・システムには、リアルタイム解析およびデファード（オフライン）解析に必
要なす べてのツールが用意されています。これらのツールには、TS（トランスポート・ストリーム）コンプライア
ンス、バッファ、PES、MPEG2、および MPEG4 のビデオおよびオーディオ・エレメンタリ・ストリーム・アナライ
ザがあります。ストリーム・コンテンツやテストおよびエラー・ストレス・ストリームを作成するためのエディタお
よびマルチプレクサもあります。

批准された DTV 規格や更新される DTV 規格を幅広くサポートするカスタマイズ可能な組込みスクリプトを
通して、規格への適合性が保証されます。新しい規格や独自仕様のテーブルは、当社が提供する更新を
読み込むか、または独自のカスタム・スクリプトを作成することにより簡単に実装できます。

ソフトウェア・アプリケーション
このセクションでは、MTS400 シリーズ MPEG テスト・システムを構成するソフトウェア・アプリケーションの概
要を簡単に説明します。一部のオプションが有効になっていない場合があることに注意してください。すべて
のアプリケーションに関する詳細な説明は、『MTS400 シリーズ・システム MPEG テスト・システム・アプリケー
ション・ユーザ・マニュアル』を参照してください。

MTS4EA 型圧縮ビデオ ES アナライザ・オプションについては、『MTS4EA 型ユーザ・マニュアル』（当社部
品番号 071-1641-XX）を参照してください。同様に、MTS4CC 型エレメンタリ・ストリーム・コンプライアンス・
チェッカ・オプションについては、『MTS4CC 型ユーザ・マニュアル』（当社部品番号 071-2075-XX）を参照
してください。

アプリケーション
デスクトップ・
アイコン 1

アナライザ

トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）：ユーザが MPEG-2、DVB、
ATSC、および ISDB から選択して適合テストを行える、リアル・タイムのトランスポート・スト
リーム解析。トランスポートの構造、ヘッダの内容、パケットの内容の 16 進表示、PCR タイ
ミング／トランスポート・レート・グラフ、およびエラー・メッセージ・ログを表示します。

トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）：ユーザが MPEG-2、DVB、
ATSC、および ISDB から選択して適合テストを行える、デファード・トランスポート・ストリー
ム解析。トランスポートの構造、ヘッダの内容、パケットの内容の 16 進表示、PCR タイミン
グ／トランスポート・レート・グラフ、およびエラー・メッセージ・ログを表示します。

トランスポート・ストリーム・コンプライアンス・アナライザ・ライト（TSCA）：解析するトランスポー
ト・ストリームのファイル・サイズが 192 MB に限定される点を除き、TS アナライザと同じです。
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アプリケーション
デスクトップ・
アイコン 1

パケット化エレメンタリ・ストリーム（PES）アナライザ：選択可能なテスト・オプションを持つ
PES 解析。PES プログラム構造、ヘッダの内容、パケットの内容、PTS/DTS タイミング・グラ
フ、および解析レポートを表示します。

トランスポート・ストリーム・システム・ターゲット・デコーダ（T-STD）バッファ・アナライザ：
MPEG-2 T-STD バッファ・モデルにおける、プログラム・ストリームの振る舞いをモデリング
し、それに対する適合性を解析します。トレース機能も搭載されています。

エレメンタリ・ストリーム・アナライザ：ビデオ映像およびオーディオ・レベルでのエレメンタリ・
ストリーム解析。これには、ベクトル・グラフとマクロブロックのピクチャ品質が含まれます。

カルーセル・アナライザ：データ項目の構造、ビット・レート、反復率、構文、およびセマン
ティクスを表示するデータ解析。

ゼネレータ

カルーセル・ゼネレータ：さまざまなデータ放送プロトコルを含む MPEG-2 および DVB トラ
ンスポート・ストリームをオフラインで詳細に生成します。

マルチプレクサ：テーブル情報とパケット化エレメンタリ・ストリームを多重化し、新しいトラン
スポート・ストリームを合成します。新しいトランスポート・ストリームに対して非適合性および
テスト・ケースを指定できるように、きめ細かい制御が可能です。

ＴS Editor：パケット・コンテンツの 16 進表示とヘッダのセマンティクス解釈を使用して、トラ
ンスポート・ストリーム・パケットの表示および編集を行います。PID の再マッピング、PCR 値
の再計算、PCR 誤差の導入などの機能を提供します。

プレーヤ

MPEG Player：MPEG-2 ストリームの記録と再生を行います。

（MTX100B 型／RTX100B 型／RTX130B 型の各プレーヤについては、それぞれのユーザ・
マニュアル、『MTX100B 型ユーザ・マニュアル』（当社部品番号 071-1927-XX）、『RTX100B
型ユーザ・マニュアル』（当社部品番号 071-1930-XX）、および『RTX130B 型ユーザ・マニュ
アル』（当社部品番号 071-1933-XX）で説明されています。）

ユーティリティ
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アプリケーション
デスクトップ・
アイコン 1

Make Seamless Wizard：連続ループ操作でストリーム・プレーヤを使用するための MPEG-2
ファイルを作成する手順を案内します。

ストリーム・カッタ：MPEG-2 ファイルのセクションを新しいファイルに抽出します。

スクリプト･パッド：ユーザがシステム情報（SI）スクリプトの作成と変更を行えるようにします。

TTS ユーティリティ：タイム・スタンプ付きのトランスポート・ストリームを標準的なトランスポー
ト・ストリーム形式に変換します。

1 インストールされている場合
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アプリケーションの起動
アプリケーションはすべて、Start > All Programs > Tektronix MTS400 メニューから起動されます。

MTS400 シリーズ・システム・アプリケーション・ユーザ・マニュアルに、すべてのアプリケーションの説明が記
載されています。以下の表は、Start メニューのアプリケーション階層を示しています。

メニュー階層

Analyzers > Buffer Analyzer

Carousel Analyzer

ES アナライザ

PES アナライザ

TS Compliance Analyzer

Carousel Generator

Multiplexer

Generators >

TS Editor

Player > MPEG Player 1

Make Seamless Wizard

ScriptPad

Stream Cutter

Utilities >

TTS Utility

Tektronix MTS400 >

OptionKey Wizard

1 MTX100B 型／RTX100B 型／RTX130B 型 MPEG Player の場合：Start > Programs > Tektronix > MPEG Player

注： Start メニューに表示されるアプリケーションのうち、開くことができるオプションは購入済みのものだけ
です。
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デュプレックス操作
MTS400 シリーズ・システム（MTS400P 型を含む）は、デュプレックス・モードでの操作が可能です
（ASI/SMPTE/DVB Parallel（SPI）のみ）。たとえば、プレーヤがストリームを再生しているときに、トランスポー
ト・ストリーム・コンプライアンス・アナライザが別のストリームを解析できます。または、出力が入力へルー
プバックされる場合は、プレーヤの出力をトランスポート・ストリーム・コンプライアンス・アナライザ（TCSA）
で監視できます。

注： デュプレックス操作は MTX100B 型／RTX100B 型／RTX130B 型では使用できません。

セットアップ、ループバック

ループバックを実行すると、次のことが可能になります。

MPEG Player を使用してストリームを再生する

機器の出力を入力へループバックする

TSCA を使用して入力ストリームを監視／解析する

開始する前に：

再生するストリームを識別する（この例では、sym1.mpg テスト・ストリームを使用）

出力／入力インタフェース（ASI/SMPTE310 または DVB SPI）を選択し、機器の後部で必要な接続（コネ
クタ間のループ）を行う

次の例では、ASI インタフェースを使用してストリームをループ・バックし、ストリームをプレーヤ内でループし
ます（連続再生のために）。

注： BNC コネクタを介して信号を入力するには ASI または SPMTE310 を選択できます。DVB SPI 出力は、
プレーヤの設定にかかわらず、常に利用可能です。IP は使用できません。

MPEG Player のセットアップ:

1. MPEG プレーヤを開きます：Start > Programs > Tektronix MTS400 > Player > MPEG Player の順に選択
します。

2. ストリームを開きます：File > Open… > sym1.mpg の順に選択します。

3. Play メニューで次の設定を行います。

Packet size： 188

Update：On

Sync：TS Packet

Loop：On

Other：Standard：DVB
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TSCA のセットアップ:

1. TSCA を開きます：Start > Programs > Tektronix MTS400 > Analyzers > TS Compliance Analyzer の順に
選択します。

2. 最初に表示されるダイアログ・ボックス（Open Transport Stream...）の Stream Interpretation で、Change...
を選択し、拡張機能のない DVB ベース規格を選択します。Stream Interpretation ダイアログ・ボックスを
閉じます。

3. Real-time Analysis を選択し、Interfaces ドロップダウン・リストから ASI を選択します。

4. OK を選択します。

再生と解析の開始:

1. MPEG Player ウィンドウに戻り、次の手順でストリームを再生します。Play > Start/Stop またはツール・
バー・ボタンを使用します。

2. プレーヤ・ウィンドウでは、ステータス・バーが表示され、再生が開始されています。

3. TSCA ウィンドウに戻ると、解析が開始されています。

MPEG Player は sym1.mpg トランスポート・ストリームを再生中であり、TSCA は、機器コネクタ・パネルの ASI
入力および出力を介してストリームを監視および解析しています。

MPEG Player および TSCA の詳細については、『MTS400 シリーズ・アナライザ・アプリケーション・ユーザ・
マニュアル』を参照してください。
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手順

MTS400 シリーズ・アプリケーションの使用
MTS400 シリーズ解析ツールセットの各アプリケーションは、トランスポート・ストリームの特定の側面または層
を対象としています。以下の図は、この原理を簡略化された形で示しています。

このチュートリアルでは、アプリケーションの起動方法、以前に作成されたテスト・ストリーム（testmux.mpg）の
解析方法、および提示される結果について説明します。結果を解釈する方法については説明しません。

トランスポート・ストリーム・コンプライアンス・アナライザ

TSCA は、トランスポート・ストリームをリアルタイムおよびオフラインで解析して、さまざまな DTV 規格に適合
するかどうかをチェックします。ストリームは、さまざまな RF および IPTV インタフェースから受信できます。
TSCA の実際の用途については、「TSCA を用いたストリーム・コンテンツの検証」セクションを参照してくださ
い。 (68 ページ 「TSCA を用いたストリーム・コンテンツの検証」 参照)。
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PES アナライザ

ビデオ、オーディオ、および補助データなどの各エレメンタリ・ストリームは、パケット化エレメンタリ・ストリーム
（PES）としてまとめられます。ここで特に注目すべき点は、トランスポート・ストリーム内の各 PES パケットに関
連付けられているヘッダです。このヘッダには、含まれているエレメンタリ・ストリームに対応するデコード・タ
イムスタンプとプレゼンテーション・タイムスタンプ（DTS と PTS）が含まれています。これらのタイムスタンプ
にエラーがあると、極端な場合には受信側でリセットまたはピクチャの静止といった問題が発生します。

1. PES アナライザを開くには、Start
> Program > Tektronix MTS400 >
Analyzers > PES Analyzer の順に
選択します。

2. File > New を選択します。トランス
ポート・ストリーム（以前に作成され
たストリーム testmux.mpg など）を探
して、開きます。

解析の進行状況が、ステータス・
バーとイベント・ログに表示され
ます。解析が完了すると Program
Structure ビューが表示されます。
この例では、ストリームで 1 つのプ
ログラムを伝送し、そのプログラムに
は 1 つのビデオ・エレメンタリ・スト
リームと 1 つのオーディオ・エレメン
タリ・ストリームが、それぞれ PID 33
と 34 として含まれていることが分か
ります。
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3. Program Structure ビューでビデオ・
ストリームを選択します。虫めがね
アイコンは、そのストリームが選択さ
れていることを示します。

4. View メニューで各ビュー・オプション
（つまり、Event Log、Hex、Interpre-
tation、および PTS/DTS Timing）を
開きます。それぞれのアクションに
より、PES Analyzer ウィンドウに新し
いビューが開きます。ウィンドウ内に
ビューをタイル表示するには、Win-
dow > Tile オプションを使用します。

ステータス・バーの上にあるスライ
ダ・バーを使用すると、PES ストリー
ム内の任意のパケットに移動できま
す。パケットには、ファイル内のそれ
ぞれに位置に応じて、PID 内に番
号が付けられています。スライダ・
バーには、現在のパケットのパケッ
ト番号と PID が表示されます。

Packet Hex ビュー：

このビューでは、PES に含まれるすべ
てのバイトを調べることができます。

左の列の 4 桁の数値は、その行の
最初のバイトのアドレスです。

マゼンタで表示されているバイトは、
PES パケット・ヘッダであることを示
しています。このヘッダは、Packet
Interpretation ビューにグラフィック
形式で表示することができます。
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Packet Interpretation ビュー：

このウィンドウでは、現在選択されてい
るパケットのヘッダを解釈してグラフィッ
ク形式で表示します。ヘッダのサイズ
は、パケット・コンテンツによって異なり
ます。

PTS/DTS ビュー：

このビューには、選択したストリームの
タイミング解析が表示されます。X 軸に
はストリームの継続期間が秒単位で表
示されます。Y 軸には DTS の予想値
と実際値の差が表示されます。垂直の
青い線は、アクセス・ユニットごとの PTS
と DTS の差を表します。その他のアク
セス・ユニットについての情報は、サイ
ド・パネルに表示されます。

準拠しているストリームの場合は、0 ms
の Y軸上に各DTS が表示されます。エ
ラーがあるストリームの場合は、通常、
階段状に表示されます。

グラフを拡大縮小するには、ツール・
バーの虫めがねを選択し、ビューをク
リックします。このウィンドウの下部にあ
るスライダは、表示されているパケット
の、ファイルの残りの部分との相対的な
位置関係を示します。
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T-STD バッファ・アナライザ

T-STD バッファ・アナライザは、仮想的なトランスポート・ストリーム・システム・ターゲット・デコーダでのバッ
ファの動作を、ISO/IEC 13818-1 の仕様に合わせてモデリングし、ビデオ、オーディオ、およびシステム制御
の各ストリームを処理することができます。解析結果は、時間に沿ったバッファ容量のグラフ、および例外と
注目すべきイベントのログとして表示されます。バッファ・モデルに適合していないと、フレームが静止したり
受信側のリセットが発生することがあります。

1. T-STD バッファ・アナライザを開く
には、Start > Program > Tektronix
MTS400 > Analyzers > Buffer Ana-
lyzer の順に選択します。

2. 設定内容を確認するには、View >
Settings を選択します。

Settings ダイアログ ・ボックスの
System タブで、Packet Interpreta-
tion の MPEG2 を選択し、Pre-Scan
Packets の All Packets を選択しま
す。
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3. Video タブで、Buffer Sizes の Au-
tomatic と、Data Transfer の Auto-
matic を選択します。

4. Audio タブで、Buffer Size の Auto-
matic を選択します。

5. Settings ダイアログ・ボックスを閉じ
ます。
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6. 解析するファイルを選択するには、
File > New の順に選択します。

7. MPEG ファイルを探して、開きます。
たとえば、以前の使用例で作成した
testmux.mpg を開きます。

開くとすぐに、別のファイル選択ダ
イアログ・ボックスが開きます。この
ダイアログ・ボックスでは、バッファ・
モデル結果（BMR）ファイルに名前
を付けて開きます。このファイルに
は、これ以降の解析結果が保存さ
れます。

デフォルトの名前を受け入れ、ファ
イルを開きます。

プログラムにより初期解析が実行さ
れ、ストリーム・リストの作成と平均ト
ランスポート・レートの計算が行われ
ます。ストリーム・リストには、ファイ
ル内のプログラムとエレメンタリ・スト
リームがすべて表示されます。この
セッションではリスト内のすべてのス
トリームに対してまだ解析が行われ
ていないため、すべてのストリーム
に Unprocessed という表記がつきま
す。

8. トランスポート・ストリームのコンテキ
スト・メニューから Process Streams
を選択して、ストリームの処理を開
始します。

解析の進捗がステータス・バーに表
示されます。
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9. PID 33 をハイライト表示し、コンテ
キスト・メニューから All Buffers を選
択します。

1 つのビデオ・エレメンタリ・ストリー
ムに関して、PID Event Log、Video
Transport Buffer、Video Multiplex
Buffer 、および Video Elementary
Buffer の各ウィンドウが表示されま
す。（Stream List ウィンドウは最小
化されています。）

10.表示されたウィンドウを並べて表示
するには、Window > Tile を選択し
ます。

PID Event Log：

次の 2 つのイベント・ログ、初期解析中
に発生する高レベル・イベントを表示
するグローバル・イベント・ログ（View >
Global Event Log）と、処理された PID
ごとのイベントを表示する PID イベント・
ログ（View > PID Event Log）を開くこと
ができます。

以下で説明するバッファ・グラフ・ビュー
には、次の機能があります。

ツール・バーの虫めがねアイコンを
使用して、選択したグラフを拡大縮
小できます。倍率値は、Reset Zoom
ツール・バー・ボタンでリセットでき
ます。

開いているすべてのグラフを、個別
に表示したり操作することがきます。
現在選択されているビューとすべて
のビューを同期させるには、Options
> Synchronize Views を使用します。

赤色のY軸の線は、0%および 100%
の限界を示しています。
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Video Multiplex/Main Buffer：

このビューには、ビデオ・ストリームに対
するマルチプレクス・バッファのモデリ
ング結果が表示されます。オーディオ・
ストリームおよびシステム制御ストリーム
に対しては、メイン・バッファの結果が
表示されます。タイトル・バーにはスト
リーム・タイプが表示されます。

Video Transport Buffer：

このビューには、ビデオ・ストリームに対
するマルチプレクス・バッファのモデリ
ング結果が表示されます。

Video Elementary Buffer：

このビューには、該当するビデオ・エ
レメンタリ・ストリームのみが表示されま
す。

11.View > Trace を選択して、トレース・
ログを表示します。

トレース・ログを使用すると、バッファ・
アナライザにより作成されたメッセー
ジ・ログを解析できます。これらのロ
グは、内部処理、特にビデオ・スト
リーム・タイプを詳細に解析するの
に役立ちます。トレース・ビューに
は、関心のある特定のメッセージ・
タイプに絞り込むためのフィルタリン
グ機能が備わっています。
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エレメンタリ・ストリーム・アナライザ

ES アナライザは、次世代の VC-1、AVC/H.264、および MPEG-4 の各規格、または従来の MPEG-2 と H.263
の各規格のいずれかに対する CODEC の適合性をチェックします。MPEG-2 オーディオ（ISO/IEC 13818
Part 3 および 7）、AC-3、および MPEG-4 AAC のオーディオ・デコードと波形表示もサポートされています。

ES アナライザは、ビデオ・ストリームおよびオーディオ・ストリームのさまざまな側面の解析に使用できる複合
アプリケーションです。このため、以下の手順では一部の解析画面へのアクセス方法を示しています。各画
面の内容とその意味の詳細については、『MTS400 シリーズ・アナライザ・アプリケーション・ユーザ・マニュ
アル』を参照してください。

1. ES アナライザを開くには、Start
> Program > Tektronix MTS400 >
Analyzers > ES Analyzer の順に選
択します。

2. 解析するファイルを選択するには、
File > New の順に選択します。

MPEG ファイルを探して、開きます。
たとえば、以前の使用例で作成した
testmux.mpg を開きます。

3. ナビゲーション・ウィンドウの各ノー
ドを順にクリックして、Program 1 /
PES (PID 33)、MPEG 2 Video ブラ
ンチの GOP（Group of Pictures）を
ハイライト表示します。
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4. Picture Player タブを選択します。
Picture Player のリモート・コントロー
ルが表示されます。

5. Show Information ボタンをクリックす
ると、コントロール・バーが拡大しま
す。追加情報として、表示されてい
るピクチャのファイル内の位置が示
されます。ステータス・バーには詳
細情報が表示されます。

6. コントロール・バーの再生ボタンをク
リックして、ストリームの再生を開始
します。

再生を停止すれば、他の GOP タブ
（GOP And Picture、Slice And MB）
を選択して、そのフレームの特性を
調べることができます。

7. たとえば、Slice And MB タブで
Picture Display を選択します。この
ピクチャは、Picture Player のピク
チャに対応します。

8. Picture Display の右側にある Show
MV（動きベクトル）をクリックします。
B および P フレームでは、動きベク
トルは、ピクチャに重なって表示され
る色付き矢印として表示されます。
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さらに、マウスをピクチャのマクロブ
ロック上に置くと、ピクチャを構成し
ているマクロブロックの特性を表示
できます。

9. Previous Frame ボタンおよび Next
Frame ボタンを使用すると、ストリー
ム内を前後に移動して、動きベクト
ルを比較できます。

同様の方法で、オーディオ・ストリー
ムの特性も調べることができます。

10.ナビゲーション・ウィンドウの各ノー
ドを順にクリックして、Program 1 /
PES (PID 34)、MPEG 1 Audio ブラ
ンチの GOP（Group of Pictures）を
ハイライト表示します。

オーディオ・コントロール・バーを使
用すると、オーディオ・トラックを確
認できます。出力を聴取するには、
ヘッドフォンを使用する必要があり
ます。
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MTS400 シリーズ・システムのリカバリ
MTS400 シリーズのシステム・ソフトウェアに問題が生じた場合は、このセクションの手順に従って、システム
を出荷時のデフォルトのインストレーションと設定に戻します。

注： 交換用ディスクとして当社に注文したハード・ディスク・ドライブに交換した後でソフトウェアをリストアす
る場合は、ハード・ディスク交換キットに付属の指示書に従ってください。

注： このセクションで説明する手順は、MTS400P 型または MTX100B 型／RTX100B 型／RTX130B 型には
適用されません。

概要

これらの手順では、システムに同梱されていた MTS400 シリーズ・システムのリカバリ・メディアが必要です。
次の表を参照してください。

数量 説明 当社部品番号

1 ソフトウェア・パッケージ：オぺレーティング・システムのリ
ストア DVD、MTS400 シリーズ MPEG テスト・システム

063-4220-XX

1 ソフトウェア・パッケージ：MTS400 型 MPEG テスト・シス
テム・インストール CD-ROM

063-4196-XX

注意： このリカバリ手順は、ドライバのインストールやネットワークのシステム設定に精通している認定され
た技術者のみが実行するようにしてください。
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このセクションの手順には、次のヒントが当てはまります。

後述の手順で特別な指示がある場合を除き、デフォルト設定を使用します。

これらの手順ではCD-ROM ドライブは "D：" ドライブとします。

手順によっては、最後にシステムを再起動するよう指示されます。その場合、再起動を求めるプロンプト
が表示されたら、Yes を選択します。プロンプトが表示されない場合は、Start メニューで Shutdown を選
択してから Restart the computer を選択します。

この付録の手順では、次の方法を説明します。

オペレーティング・システムを出荷時のデフォルト設定に戻す

SCSI ドライブを復元する（必要に応じて）

MTS400 シリーズ・システム・アプリケーションをインストールする

ソフトウェア・ライセンスのオプション・キーを再設定する

SCSI ドライブを再フォーマットする（必要に応じて）

システムの構成要素は次のとおりです。

Microsoft Windows XP Professional Service Pack 3

Internet Explorer 6.0 SP2

SigmaTel C-Major サウンド・ドライバ

Mobility Radeon 7500 ディスプレイ・ドライバ（ATI）

Tektronix Soft Power Down ドライバおよびシャットダウン・サービス

Intel EtherExpress PRO/100B および PRO/1000 PCI アダプタ・ドライバ

Symbios SCSI ドライバ

Nero CD/DVD 書込みソフトウェア

Intel アプリケーション・アクセラレータ

Intel INF Update

Media Player 11

Tektronix MTS400 シリーズ・システム MPEG テスト・システム・アプリケーション・ソフトウェア

42 MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル



手順

オペレーティング・システムのリストア

状況によっては、停電が発生したりファイルが誤って削除されたりした場合のように、システムがハード・ディ
スクからのブートに失敗することがあります。このような状況が発生した場合は、MTS400 シリーズ・システム
のリカバリ・メディアを使用して、ハード・ディスクを出荷時のデフォルト・インストール状態にリストアします。

注意： ライセンスされたアプリケーションを使用できなくなることのないよう、リカバリには機器に付属の MTS400
シリーズ・システムのリカバリ・メディア（またはそのアップグレード版）を使用してください。

MTS400 シリーズ・システム・オペレーティング・システムのリストア: MTS400 シリーズ・システムの
オペレーティング・システムをリストアするには、次の手順に従います。このリストア・プロセスが有効なのは、
ハード・ディスクがまだ正常な場合のみです。このプロセスでは、オペレーティング・システムとアプリケーショ
ン・ソフトウェアがリストアされます（このプロセスは 30 分以内に完了します）。

注意： データの損失を防ぐために、ハード・ディスクをバックアップしてから MTS400 シリーズ・システムをリ
ストアしてください。システムのリストア処理を行うと、ハード・ディスク上のすべてのデータが消去されます。

CD-ROM ドライブに MTS400 シリーズ・システム・オペレーティング・システムのリストア DVD を挿入した
状態で MTS400 シリーズ・システムを起動します。リカバリ・アプリケーションが自動的に開始されます。

"1" キーを押して、システム・リストア・プロセスが開始します。Acquiring Device ダイアログ･ボックスが短
時間表示され、進行状況バーが表示されます。

システムのリストアが完了したら、CD-ROM ドライブから DVD を取り出し、任意のキーを押してから "4"
キーを押します。

メッセージが表示されたら、 “Y” キーを押して機器を再起動します。
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SCSI ドライブの復元: オペレーティング・システムのリストア後、SCSI ドライブ（ドライブ E および F）がシ
ステムから認識されていることを確認してください。次の図は、Windows エクスプローラに表示されたドライブ
を示しています。

ドライブ（E および F）が Windows エクスプローラに表示されない場合は、次の手順を実行して、システムが
これらのドライブを認識できるようにします。

1. Windows の Disk Management ウィ
ンドウを開きます（Start > Con-
trol Panel > Performance and Main-
tenance > Administrative Tools >
Computer Management > Storage >
Disk management）。

Disk 0 および Disk 1 が Foreign と
記述されています。
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2. Disk 0 または Disk 1 を右クリック
し、コンテキスト・メニューで Import
Foreign Disks を選択します。

3. Import Foreign Disks ダイアログ･
ボックスで、ディスク・グループが選
択されていることを確認して OK を
選択します。
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4. Foreign Disk Volumes ダイアログ･
ボックスで OK を選択します。

5. ディスクが、図のように表示されま
す。

これで「MTS400 シリーズ・オペレーティング・システムのリストア手順」は完了です。
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MTS400 シリーズ・システム・アプリケーションのインストール

MTS415 型または MTS430 型に MTS400 シリーズ・システムのアプリケーションをインストールする手順は、
スタンドアロン型のインストール手順に似ています。

「MTS4SA 型スタンドアロン・システムのインストール」のセクションで、MTS400 プラットフォームを選択して
インストールを続けます。

MTS400 シリーズのアプリケーションのインストール後に、ソフトウェア・ライセンス・キーを復元する必要がある
ことに注意してください。これに関しては、スタンドアロンのインストール手順でも説明されています。 (8 ペー
ジ 「MTS4SA 型スタンドアローン・システムのインストール」 参照)。
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SCSI ドライブの再フォーマット

注意： SCSI ドライブをリセットすると、ドライブに格納されているすべてのデータが失われます。重要なデー
タは必ずバックアップするようにしてください。

MPEG ファイル・ストレージには、2 つの SCSI（Small Computer System Interface）ハード・ディスク・ドライブが
使用されています。これらのドライブが破損したら、次の手順を使用してリセットする必要があります。

1. MTS400 シリーズ・システム・オペレーティング・システムのリストア DVD を CD-ROM ドライブに挿入しま
す。SCSI_DRV フォルダに移動します。

2. SCSI_DRV フォルダをそのまま C：ドライブにコピーします。このフォルダには次のファイルが格納されて
います。

drives.bat

readme.doc

complete.txt

complete2.txt

3. MTS400 シリーズ・システムのオペレーティング・システムのリストア DVD を取り出します。

4. SCSI_DRV フォルダで、drives.bat というファイルを実行します（ファイル名をダブルクリックします）。

5. プロセスが完了したら、機器を再起動します。
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使用例

このセクションでは、次の使用例について説明します。

次のようなトランスポート・ストリームの作成、表示、および解析

マルチプレクサ・アプリケーションを使用した新しいトランスポート・ストリームの作成

トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）アプリケーションでの FlexVuPlus™ の
セットアップ

TSCA アプリケーションによる作成したストリームのコンテンツの調査

PES アナライザ、T-STD バッファ・アナライザ、および ES アナライザの各アプリケーションによる作成した
ストリームの検査

トランスポート・ストリームの作成、表示、および解析
以下の使用例では、新しいトランスポート・ストリームの作成方法と、そのストリームにおけるエラーの有無の
確認方法について説明します。

マルチプレクサを使用した新規ストリームの作成

使用例のこのセクションでは、MTS400 シリーズ・マルチプレクサ・アプリケーションを使用して新しいトランス
ポート・ストリームを作成します。意図的にエラーを 1 つ加えて、使用例の後のセクションでその影響を確認
できるようにします。

1. マルチプレクサ・アプリケーショ
ンを開くには、Start > Programs >
Tektronix MTS400 > Generators >
Multiplexer の順に選択します。
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2. View > Interpretation を選択しま
す。

3. Stream Interpretation ダイアログ・
ボックスで、Base Standard として
DVB が選択され、Region が None
になっていることを確認します。

4. OK を選択して、Stream Interpreta-
tion ダイアログ・ボックスを閉じます。

5. File > New を選択します。

6. Navigator ウィンドウで、Transport
Stream ノードをハイライト表示し、コ
ンテキスト・メニューから Properties
を選択します。

7. Stream Properties ダイアログ・ボッ
クスで、ビット・レートとして 24.128
MBps を入力し、固定継続期間とし
て 2 分（120 秒）を入力します。OK
を選択します。

この 2 つの値がステータス・バーに
表示されていることに注意してくだ
さい。
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8. Navigator ウィンドウで、Transport
Stream ノードをハイライト表示し、
コンテキスト・メニューから Add を選
択します。

9. Transport Stream Settings ダイアロ
グ･ボックスで、Transport Stream ID
に「1」を入力します。

10.PAT（Program Allocation Table）フォ
ルダ・アイコン・ボタンを選択して、
PAT Timing ダイアログ・ボックスを
開きます。

Version Timing タブ・ウィンドウに表
示されている PAT タイミングの Start
Time（0 秒）と Stop Time（120 秒）
は、PAT がこのストリーム継続期間
で送信されることを意味しています。

11.OK を選択して、PAT Timing ダイア
ログ・ボックスを閉じます。

12.Transport Stream Settings ダイアロ
グ・ボックスで、Next を選択します。
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13.Optional Tables for the Stream ダイ
アログ・ボックスで、TDT（Time and
Date Table）チェック・ボックスを選
択し、TDT フォルダ・アイコン・ボタ
ンを選択します。

TDT Timing ダイアログ・ボックスで、
Start Time がゼロに設定され、Stop
Time が前に設定した継続期間と同
じ値に設定されていることを確認し
ます。

この継続時間は、若干調整されて
いる場合があるので注意してくださ
い。この例では、120 秒と設定した
継続期間が 119.99999049 と表示さ
れています。

14.Cycle Time に「1000」ms と入力しま
す。

15.OK を選択して、TDT Timing ダイア
ログ・ボックスを閉じます。

16.Optional Tables for the Stream ダ
イアログ・ボックスで、NIT（Network
Information Table）チェック・ボックス
を選択し、NIT Settings ボタンを選
択します。
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17. Set up the NIT ダイアログ･ボック
スで、Network Id に「1234」、また
Network Name に「Tek_test」と入力
します。

18.Original Network Id を 2 に設定し、
Delivery System ドロップダウン・リス
トから Terrestrial を選択します。

19.Delivery System の Settings ボタン
を選択します。

20.Terrestrial Settings ダイアログ･ボッ
クスで、Centre Frequency フィール
ドに「0x123456」と入力します。

21.Constellation ドロップダウン・リスト
から 2 (64-QAM) を選択します。

22.Hierarchy Info ドロップダウン・リス
トから 4 (non-hierarchical, in-depth
interleaver) を選択します。

23.Transmission Mode ドロップダウン・
リストから 1 (8k mode) を選択しま
す。

24.OK を選択して、Terrestrial Settings
ダイアログ・ボックスを閉じます。

25.OK を選択して、Set up the Nit ダイ
アログ・ボックスを閉じます。
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26.Optional Tables for the Stream ダイ
アログ・ボックスで、Next を選択し、
Transport Wizard Complete ダイア
ログ・ボックスを表示します。

以上でトランスポート・ストリームの
セットアップは完了です。ここで、何
らかのコンテンツをビデオ・エレメン
タリ・ストリームおよびオーディオ・エ
レメンタリ・ストリームの形式で追加
する必要があります。

エレメンタリ・ストリームのアクイジション: この例では、作成したトランスポート・ストリームに、ビデオ・
エレメンタリ・ストリームとオーディオ・エレメンタリ・ストリームを追加する必要があります。MTS400 型のインス
トールに付属しているサンプルのトランスポート・ストリームのいずれかから適切なストリームを解凍できます。
推奨のストリームは Sym1.mpg で、これは MTS400 シリーズの E：ドライブにあります。

1. マルチプレクサの 2 つ目のインスタ
ンスを開きます。Start > Programs >
Tektronix MTS400 > Generators >
Multiplexer の順に選択します。

2. File > Open を選択します。

3. Set MPEG File to Edit ダイアログ･
ボックスで、sym1.mpg を検索して開
きます。
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4. プログラム 1 のノードと、それに従
属する Elementary Streams ノードを
展開します。

5. PID 110 ノードをハイライト表示しま
す。この PID では、MPEG-2 ビデ
オ・エレメンタリ・ストリームが伝送さ
れます。es ファイル拡張子が自動
的に追加されます。

6. コンテキスト・メニューから Export
Elementary Stream を選択します。

7. Save As ダイアログ･ボックスで、ファ
イル名（「Sym1pid110.es」）を入力
し、適切な場所にファイルを保存
します。

8. PID120 でおこなった操作を繰り返
します。ファイルに、Sym1pid120.es
と名前を付けます。

9. Mux のインスタンスを閉じるには、
File メニューの Exit を選択します。

これでエレメンタリ・ストリームの解凍は
完了です。多重化の作業に戻ります。

エレメンタリ・ストリームの追加: ここで、元のマルチプレクサ・インスタンスに戻り、先程作成したエレメン
タリ・ストリームを追加できます。

1. Add a Program Wizard がオンになっ
ていることを確認し、Next を選択し
ます。手順 26 を参照してください。

2. Add a Program ダイアログ・ボックス
で、プログラム番号として 1 を入力
します。
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3. PMT Timing ダイアログ・ボックスで、
Subtable Timing タブを選択します。

サブテーブル・タイミング・サイクル
時間とは、ストリーム内でテーブルが
繰り返される期間のことです。DVB
規格における PMT の最大サイクル
時間は 500 ms です。

4. このストリーム例では、サイクル・タ
イムを「525」ms に設定します。

5. OK を選択して、PMT Timing ダイア
ログ・ボックスを閉じます。

6. Add A Program ダイアログ・ボックス
で、Next を選択します。

7. Add Service Description ダイアログ・
ボックスで、Add Service Description
チェック・ボックスを選択します。

8. Service Provider Name （ 「 Tek
Broadcasting」 など）を入力します。

9. Service Name（「Tek1」 など）を入力
します。

10.Service Type（「1 (0x1) (digital tele-
vision service) 」など）を入力します。

11.Next を選択します。

12.Add the Program Content ダイアロ
グ・ボックスで、Add を選択し、ビデ
オ・エレメンタリ・ストリームを追加し
ます。
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13.Add Program Stream ダイアログ･ボッ
クスで、Stream Type ドロップダウン・
リストから 2 (0x02)（MPEG-2 ビデオ）
を選択します。

14.Source タブが選択されていることを
確認します。

15.File name を入力するか、Browse
を使用して以前セットアップした
ビデオ・エレメンタリ・ストリーム
（Sym1pid110.es）を探します。

16.File type ドロップダウン・リストで
MPEG-2 video を選択します。ファ
イルのビット・レートは自動的に入力
されます。

Timing タブを選択します。エレメン
タリ・ストリームは、以前に設定した
ストリーム長、つまり 120 秒間実行
されることに注意してください。

17.PCR タブを選択します。Carry PCR
チェック・ボックスが選択されている
ことを確認します。

MTS400 シリーズ・クイック・スタート・ユーザ・マニュアル 57



使用例

18.OK を 選 択 し て 、 Add Program
Stream ダイアログ・ボックスを閉じ
ます。

19.Add Program Content ダイアログ・
ボックスで、Add を再度選択し、オー
ディオ・エレメンタリ・ストリームを追
加します。

20.Stream Type ドロップダウン・リストか
ら 3 (0x03) (MPEG-1 Audio) を選択
します。

21.Add Program Stream ダイアログ･ボッ
クスで、Source タブが選択されてい
ることを確認します。

22.File name を入力するか、Browse ボ
タンを使用して以前セットアップした
オーディオ・エレメンタリ・ストリーム
（Sym1pid120.es）を探します。

23.File type ドロップダウン・リストから
MPEG-2 audio を選択します。ファ
イルのビット・レートは自動的に入力
されます。

24.Timing タブを選択します。エレメン
タリ・ストリームは、以前に設定した
ストリーム長、つまり 120 秒間実行
されることに注意してください。

25.PCR タブを選択します。Carry PCR
チェック・ボックスがオフになってい
ることを確認します。

26.PCR PID フィールドに「33」と入力し
ます。これは PCR 情報を含む PID
であり、ビデオ es、Carry PCR も含
まれます。

27.OK を 選 択 し て 、 Add Program
Stream ダイアログ・ボックスを閉じ
ます。

28.Next を選択します。
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29.Event Information ダイアログ・ボッ
クスで、Event Information Tables
(EIT) チェック・ボックスを選択しま
す。

30.Present チェック・ボックスが選択さ
れていることを確認します。

31.Present Settings を選択します。

32.Present Events ダイアログ・ボックス
で、Add を選択して、現在のイベン
ト情報、つまり、この放送の時間を
セットアップします。Event dialog ダ
イアログ・ボックスで、Status ドロップ
ダウン・リストから 4 (running) を選択
します。

33.Start Time を 2008-08-28 10:20:00
AM に設定します。

時間と日付は、各フィールドをハイ
ライト表示し、必要な値を入力する
ことにより変更できます。

34.Event Name（「Tek World」 など）を
入力します。

35.Description（「The future of Tek」 な
ど）を入力します。

36.Duration（30 分（「00:30:00」）など）
を入力します。

37.Content/Component Type ドロップ
ダウン・リストから 257 (MPEG-2
video, 4:3 aspect ratio, ...) を選択
します。

38.OK を選択して、Event ダイアログ・
ボックスを閉じます。

39.OK を選択して、Present Events ダ
イアログ・ボックスを閉じます。
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40.Following チェック・ボックスが選択
されていることを確認します。

41.Following Settings を選択します。

42.Add を選択して、以降のイベント情
報、つまり、現在のイベントに続くイ
ベントをセットアップします。

43.Event ダイアログ･ボックスで、Event
Id フィールドに「1」と入力します。

44.Status ドロップダウン・リストから 1
(not running) を選択します。

45.Start Time を 2008-08-28 10:50:00
AM に設定します。

46.Event Name（Tek News など）を入力
します。

47.イベントの Description（All the latest
news from Tek など）を入力します。

48.Duration（30 分（01:00:00）など）を
入力します。

49.Content/Component Type ドロップ
ダウン・リストから 257 (MPEG-2
video, 4:3 aspect ratio, ...) を選択
します。

50.OK を選択して、Event ダイアログ・
ボックスを閉じます。

51.OK を選択して、Following Events ダ
イアログ・ボックスを閉じます。

52.Next を選択します。
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53.Program Complete ダイアログ・ボッ
クスで、Finish を選択します。

提案されたトランスポート・ストリームの
構造とコンテンツの作成が完了しまし
た。以上で、いくつかのチェックを行っ
て、ストリームが正常にコンパイルされ
ることを確認できるようになりました。

54.View > Available Bitrate を選択しま
す。

Available Bitrate グラフで、ビット・
レートが必須ビット・レート（つまり、
124.128 Mbps）内に収まっているこ
とに注意してください。

グラフ上の任意の点におけるビット・
レートを調べるには、その点をクリッ
クし、隣のテーブルから値を読み取
ります。

55.Available Bitrate グラフを閉じます。

56.Multiplex > Start を選択して、多重
化を開始します。
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57.Set TS Output File ダイアログ･ボック
スで、例えば「TestMux.mpg」など、
多重化された新しいトランスポート・
ストリームの名前を入力します。

多重化の進捗状況はステータス・
バーの右側に表示されます。ウィン
ドウの水平方向のサイズが小さすぎ
る場合、進捗状況バーが非表示に
なることがあります。

以上で、エレメンタリ・ストリームと
構造情報が 1 つに多重化され、
TestMux.mpg というトランスポート・
ストリームが作成されました。

58. この多重化の構造は、後で必要に
応じて呼び出したり、情報を追加し
たりできるよう、保存しておくことを
お勧めします。

59.File > Export を選択します。

60.Export File ダイアログ・ボックス
で、多重化構造ファイルの名前
（TestMux.muxml など）を入力しま
す。拡張子が muxml であることに注
意してください。

61.File > Import を使用すると、いつで
も多重化構造ファイルを開いて、エ
レメンタリ・ストリームや構造情報を
追加することができます。
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FlexVuPlus™ ディスプレイのセットアップ

FlexVuPlus では、最大 4 つの解析詳細ビューを選択して同時に表示し、基本的なトランスポート・ストリーム
の監視や詳細な診断監視を容易に行うことができます。

ここでは、説明の便宜上、現在表示さ
れているすべての FlexVuPlus パネル
をいったん閉じるものとします（各パネ
ル右上隅の X をクリックします）。

これは必須ではありませんが、こうして
おけば、各パネルを配置する手順が
理解しやすくなります。これ以降は、
FlexVuPlus の各パネルを番号順に説
明します。

パネル 1 のセットアップ

1. Analysis タブをクリックし、次に Tests
タブをクリックします。

すべての詳細ビューの右上隅に
FlexVuPlus パネル選択ボタンがあり
ます。このボタンを使用して、選択し
た FlexVuPlus パネルに詳細ビュー
の複製を表示できます。

2. Test Summary ビューで FlexVuPlus
パネル選択ボタンを使用して、この
ビューをパネル 1 に複製します。
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3. これで、FlexVuPlus のパネル 1 に
Test Summary ビューが表示されま
す。

パネル 2 のセットアップ

4. Analysis タブをクリックし、次に Pro-
grams タブをクリックします。

5. Thumbnails ビューで FlexVuPlus パ
ネル選択ボタンを使用して、この
ビューをパネル 2 に複製します。
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6. これで、FlexVuPlus のパネル 2 に
Thumbnail ビューが表示されます。

パネル 3 のセットアップ

7. Analysis タブをクリックし、次に Tests
タブをクリックします。

8. Test Failures ビューで FlexVuPlus
パネル選択ボタンを使用して、この
ビューをパネル 3 に複製します。
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9. これで、FlexVuPlus のパネル 3 に
Test Failures ビューが表示されま
す。

この例では 3 つのパネルしか使用
していないので、Thumbnail ビュー
を拡大し、FlexVuPlus™ の右側全体
に表示できます。

パネルの垂直方向拡大ボタンを選
択して、パネル 2 を縦方向に拡大
できます。

（同様に、パネルを横方向に拡大
するには、パネルの水平方向拡大
ボタンをクリックします）。
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10. パネル 2 を拡大して、総合的な
FlexVuPlus 基本監視ビューのでき
あがりです。

このビューでは次の項目をすぐに確認できます。

Tests Summary ビュー（FlexVuPlus パネル 1）- 失敗したテスト

Test Failures ビュー（FlexVuPlus パネル 3）- 直近に失敗したテスト

Thumbnails ビュー（FlexVuPlus パネル 2）- ビデオ・コンテンツを配信中のエレメンタリ・ストリーム
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TSCA を用いたストリーム・コンテンツの検証

以前の使用例で作成したサンプルのトランスポート・ストリーム（testmux.mpg）を、トランスポート・ストリーム・
コンプライアンス・アナライザを用いてオフラインで検証します。

1. トランスポート・ストリーム・コンプライ
アンス・アナライザを開くには、File >
Program > Tektronix MTS400 > An-
alyzers > TS Compliance Analyzer
の順に選択します。

TSCA ツール・バーで、Open File を
選択します。

オフライン解析のセットアップを選
択する前に、Select Real-time Inter-
face ダイアログ・ボックスを閉じなけ
ればならない場合があります。

Open File Analysis ダイアログ･ボッ
クスで、Base Standard が DVB とな
り、また Region が No Extensions に
なっていることを確認します。

サンプル・ストリーム（tetsmux.mpg）
を探して、選択します。

Advanced Settings フィールドで、
Stream Bit Rate および Timestamp
Settings が表示されていることを確
認します。

解析が完了するまでには、しばらく
かかります。
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2. Analysis タブを選択し、ナビゲーショ
ン・ビューおよび関連するビューを
表示します。

3. Programs タブを選択し、プラス記号
をクリックしてナビゲーション・ビュー
の各ノードを展開します。

詳細ビューで、Summary ビューと
Tests ビューが表示されていること
を確認します。

Transport Stream ノードと Program
ノードが両方とも赤くなっています。
これは、そのストリームでエラーが発
生し、現在もアクティブであることを
示しています。

4. Transport Stream ノードをハイライ
ト表示します。Tests Summary 詳細
ビューの TR 101 290 タブで、test
1.5.a PMT がエラーを示しており、
関連する LED が赤くなっていること
に注意してください。

5. テスト 1.5.a PMT をハイライト表示
し、Tests ツリーでコンテキスト・メ
ニューから View this test を選択し
ます。

Tests タブのビューが表示されます。
ナビゲーション・ビューが展開され、
エラーになったテストが表示されま
す。詳細ビューには、ハイライト表示
されたテストに関連する PID（この例
の場合は、なし）が表示されます。
さらに、ハイライト表示されたテスト
に関するイベントのみを表示するよ
うフィルタリングされたイベント・ログ
が表示されます。

ログ・エントリにエラー情報があるか
どうかを検証します。エラー・レポー
トでは 525 ms という継続期間を参
照していることに注意してください。
これは、PMT セクションの反復レー
トです。525 ms は、以前に作成した
サンプル・ストリームで設定した値で
す。
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6. ナビゲーション・ビューで 1.5 PMT
(Timer) テストをハイライト表示し、
コンテキスト・メニューから Edit Pa-
rameters を選択します。

7. Edit Parameters ダイアログ･ボック
スで、このストリームに対して PMT
section maximum repetition interval
が 500 ms に設定されています。この
ストリームにおける反復率（525 ms）
がこの値を超えているため、エラー
としてレポートされています。ただ
し、Edit Parameters ダイアログ・ボッ
クスに表示されている最大および最
小の反復レートを調べると（マウス・
ポインタを値フィールド上に置き、
ツールチップを参照する）、525 ms
というレートが、DVB 規格で推奨さ
れている範囲（40 ms ～ 25000 ms）
内にあることが分かります。
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スタンダード・アクセサリ
以下の表では、MTS400 シリーズ製品に付属するスタンダード・アクセサリを示しています。

数量 説明 部品番号
MTS415
型

MTS430
型

MTS4SA
型

MTS4USB
型

1 適合性証明書 001-1180-XX ■ ■ ■

1 ソフトウェア・パッケージ：Tclips MPEG テ
スト・ストリーム・ソフトウェア・メディア

020-2965-XX ■ ■ ■

1 ソフトウェア・パッケージ：MTS400 シリー
ズ・アプリケーション・ソフトウェア・メディア

020-2994-XX ■ ■ ■

1 TekRestore ライセンス 063-3906-XX ■ ■

1 Certificate Of Authenticity ： Microsoft
Windows XP

NA ■ ■

1 ソフトウェア・パッケージ：MTS400 シリー
ズ・オペレーティング・システムのリストア
DVD

063-4220-XX ■ ■

1 ソフトウェア・パッケージ：MTS400 シリー
ズ製品マニュアル CD-ROM

063-4197-XX ■ ■ ■

1 ソフトウェア・パッケージ：MTS4CC ソフト
ウェア CD-ROM

063-3991-XX ■

1 ソフトウェア・パッケージ：MTS4EA ソフト
ウェア CD-ROM

063-3824-XX ■

1 Nero CD-ROM 書き込みソフトウェア、
OEM スイート 8.3

063-3781-XX ■ ■

1 MTS400 シリーズ・クイック・スタート・ユー
ザ・マニュアル

オプション L0 型（英語）

オプション L5 型（日本語）

071-2607-XX

071-2608-XX

■ ■ ■

1 補足情報シート、中国 RoHS 071-2185-XX ■ ■ ■

1 ソフトウェア・キー、パラレル・ポート

MTS4SA をオプション MTS4USB 型で使
用する場合、パラレル・ポート・キーは USB
ソフトウェア・キーで置き換えられます。

NA ■ ■ ■

1 ソフトウェア・キー、USB ポート NA ■

1 キーボード、105 キー・レイアウト 119-6989-XX ■ ■

2 ケーブル・アセンブリ：RF、BNC-BNC、75
Ω

174-4954-XX ■ ■

2 ケーブル・アセンブリDB25 174-4955-XX ■ ■
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オプショナル・アクセサリ

MTS400 シリーズ・オプショナル・アクセサリ

オプショナル・アクセサリを次に示します。

数量 説明 部品番号

COFDM RF インタフェースのみ

1 アダプタ、RF：BNC-F タイプ 015-0688-XX

1 ケーブル・アセンブリ：RF、BNC-BNC、75 Ω 174-5135-XX

QPSK/8PSK RF インタフェースのみ

1 ケーブル・アセンブリ：RF、BNC-BNC、75 Ω 174-5135-XX

QAM B RF インタフェースのみ

1 ケーブル・アセンブリ：RF、BNC-BNC、75 Ω 174-5135-XX

8VSB RF インタフェースのみ

1 アダプタ、RF：BNC-F タイプ 015-0668-XX

1 ケーブル・アセンブリ：RF、BNC-BNC、75 Ω 174-5135-XX

GigE イーサネット・インタフェース（10/100/1000Base-T RJ-45 電気ポート付き）

1 ケーブル・アセンブリ：RF、BNC-BNC、75 Ω 174-5135-XX

IPTVD Gigabit イーサネット・インタフェース（10/100/1000 Base-T R-J45 電気ポート）

1 ケーブル・アセンブリ：RF、BNC-BNC、75 Ω 174-5135-XX
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ユーザ・メンテナンス

この付録では、MPEG テスト・システムの一般的な注意事項と保守の手順について説明します。

「予防保全」では、クリーニングの手順について説明します。

「問題が発生した場合」では、起動エラーのトラブルシューティングのヒントをいくつか示します。

「輸送用の再梱包」では、機器を梱包して輸送するための手順を示します。

一般的な注意事項
機器は、厳しい気候条件から保護する必要があります。この機器は防水加工されていません。

注意： スプレーや液体、溶剤に接触させないでください。機器が損傷する可能性があります。

化学薬品の洗浄剤を使用しないでください。機器を損傷する恐れがあります。ベンゼン、トルエン、キシレ
ン、アセトンまたはこれに類似する溶剤を含有する化学薬品を使用しないでください。

予防保全
年に一度、電気的な性能をチェックし、機器の確度を検証（校正）する必要があります。

予防保全は、主に定期的なクリーニングによって実現されます。定期的にクリーニングすることにより、機器が
故障しにくくなり、信頼性が高まります。動作環境に基づき、必要に応じて機器をクリーニングする必要があり
ます。コンピュータ室のような条件に比べると、汚れた条件下ではより頻繁にクリーニングする必要があります。

外部のクリーニング

機器の外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れが落
ちない場合は、75% のイソプロピル・アルコール溶剤をしみこませた布または綿棒を使用してください。コント
ロールやコネクタ周囲の狭い箇所のクリーニングには綿棒が役立ちます。機器のどの部分にも研磨剤を使
用しないでください。

注意： 外部のクリーニング時に機器の内部が湿らないように、布または綿棒が湿る程度の量の溶剤のみを
使用してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を使用し、純水で洗い流してください。

フロント・パネルの On/Standby スイッチを水拭きしないでください。機器のクリーニング中はスイッチを覆っ
てください。
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CD ドライブのクリーニング

CD ドライブを最適の状態に保つには、定期的に保守を行う必要があります。ディスクの表面に汚れや塵が
溜まると CD が損傷する可能性があります。ディスクはすべて、汚れや塵にさらされないように保護ケースに
格納してください。

注意： 静電気放電（ESD）によって、CD-ROM ドライブのコンポーネントが損傷するおそれがあります。中央
のハブを除いて、プラッタ上にあるレンズや露出した金属部品に触れないでください。

月に一度、純水で湿らせた布を使用して CD-ROM ドライブの表面をクリーニングしてください。

注意： ディスク・ドライブの内部に湿気が入らないようにしてください。電源が入っていると、内部のコンポー
ネントが損傷する可能性があります。

キーボードのクリーニング

キーボードおよび内蔵トラッキング・デバイスの外部表面のクリーニングには、乾いた柔らかい布か柔らかい
毛ブラシを使用してください。コントロールやコネクタ周囲の狭い箇所のクリーニングには綿棒が役立ちま
す。機器のどの部分にも研磨剤を使用しないでください。

注意： 外部のクリーニング時にキーボードや内蔵トラッキング・デバイスの内部が湿らないように、布または
綿棒が湿る程度の量の溶剤のみを使用してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を
使用し、純水で洗い流してください。
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問題が発生した場合
このセクションでは、テスト・システムの使用中に発生する可能性がある問題について説明します。このセク
ションでは、性能の検査や調整に関連した具体的な問題は取り上げていません。このセクションで説明す
る の診断手順は、問題の切り分けに役立ちます。性能の検査の手順に関しては、MTS400 シリーズ製品マ
ニュアル CD-ROM で提供されている PDF ファイル、『MTS400 シリーズ仕様および性能検査テクニカル・リ
ファレンス』を参照してください。

起動時のセルフテストは、テスト・システムのアプリケーションを起動するために機器の電源を最初にオンに
したときに実行されます。これらの診断では、オペレーティング・システムとハードウェアが正しく動作すること
がチェックされます。起動時のセルフテストでエラー・メッセージが表示された場合は、ソフトウェアの起動を
妨げるシステム・エラーが存在する可能性があります。

以下の表は、オペレーティング・システムと周辺機器に関連するハードウェアの問題の症状と、考えられる解
決策のいくつかを示しています。

症状 考えられる原因と推奨される対応

機器の電源がオンにならない 電源コードが機器と電源に接続されていることを確認します。

On/Standby スイッチを押したときに機器に電力が供給されるこ
と、およびファンが動作することをチェックします。

電源から電力が供給されていることをチェックします。

当社サービス受付センターにお問い合わせください。

機器の電源がオンになっても、起動時
シーケンスが完了しない

フロッピー・ディスク・ドライブを点検してディスクを取り出し、機器
がハード・ディスク・ドライブから起動していることを確認します。

起動時のセルフテストが失敗する 当社サービス受付センターにお問い合わせください。

機器が、モニタ、プリンタ、キーボード
などのアクセサリを認識しない

アクセサリが適切に接続またはインストールされていることをチェッ
クします。

当社サービス受付センターにお問い合わせください。

On/Standby スイッチで機器の電源が
オフにならない

Windows XP のシャットダウン手順に従って機器の電源をオフにし
てみてください。それでも機器の電源がオフにならない場合は、
タスク・マネージャを使用してタスクを終了します。最後に、強制
シャットダウン手順を試してください。On/Standby スイッチを 5 秒
間押したままにして、機器の電源をオフにします。
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ソフトウェアに関する問題

MPEG テスト・システムはソフトウェアがインストールされた状態で納品されます。ソフトウェアに問題があると
思われる場合は、テスト・システムのアプリケーション・ソフトウェアの問題と、インストールされている他のソフ
トウェアの問題を区別するようにしてください。

ソフトウェアに関する問題の多くは、ソフトウェア・ファイルの破損または不足が原因になっています。ほとん
どの場合、ソフトウェアに関する問題を解決するための最も簡単な方法は、ソフトウェアを再インストールする
ことです。 (41 ページ 「MTS400 シリーズ・システムのリカバリ」 参照)。

ネットワークに問題があると思われる場合は、「ネットワークのトラブルシューティング」を参照してください。
(16 ページ 「ネットワークのトラブルシューティング」 参照)。

ハードウェアに関する問題

ハードウェアの問題にはいくつかの原因が考えられます。このマニュアルの設置手順を見直して、機器を正
しく設置していることを確認してください。MTS400 シリーズ・システムにはユーザが保守できる部品はない
ため、ハードウェアの問題が発生した場合は、当社サービス受付センターにお問い合わせいただく必要が
あります。

輸送用の再梱包
機器は、最初に当社によって、輸送中の損傷から機器を保護するための梱包資材を使用したカートンに入
れて出荷されています。機器を別の場所に輸送する必要がある場合は、輸送中に機器が適切に保護され
るように、元の輸送用カートンと梱包資材を使用することを強くお勧めします。

注意： 機器を別の場所に輸送する場合、または修理のために当社サービス受付センターに機器を返送す
る場合、機器の保証が失われないように、元の輸送用カートン（良好な状態のもの）を使用することを強くお
勧めします。

当社は、機器が損傷した状態でサービス受付センターに到着し、その原因が元のカートンまたは当社から
購入した交換用カートン（および支持用梱包資材）で輸送されていなかったことによる場合、機器の保証に
応じることはできません。元の梱包資材が紛失している場合は、当社営業所にお問い合わせいただき、交
換用梱包資材を入手してください。

梱包の検査

機器を別の場所に輸送する準備を行う場合は、現在の梱包資材の状態と、不足している資材がないかどう
かを検査することが重要です。

現在の梱包資材の状態が良くない場合、または不足している資材がある場合は、新しい梱包キットを注文
することを強くお勧めします。

交換用梱包資材

当社から新しい梱包資材を入手できます。これらの資材を入手するには、当社営業所にお問い合わせくださ
い。交換用梱包キットには、輸送のために機器を正しく梱包するのに必要な資材がすべて含まれています。
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再梱包手順

機器を輸送する場合は、機器が適切に保護されるように梱包することが重要です。修理のために機器を返
送する場合、機器と共に受け取ったアクセサリを返送する必要はありません。

注： アップグレードまたは修理のためにテスト・システムを当社サービス受付センターに返送する場合は、
ソフトウェア・キーを取り外さないでください。

1. 機器を修理のために当社営業所に輸送する場合は、次の情報を示すタグを機器に添付してください。

所有者の名前と住所

機器のシリアル番号

発生した問題および必要なサービスの説明

2. 機器の前面に前面保護カバーを置きます。

3. 機器を保護用の袋に入れます。この袋は、汚れ、湿気、およびその他の破片がキャビネットに入らない
ようにします。

4. 袋の上部を機器の上の方できれいにたたみ、できるだけ平らにして梱包用テープで止めます。

5. 機器の正面に前面緩衝材をかぶせます。

6. 機器の後面に後面緩衝材をかぶせます。

7. 前後の緩衝材を付けた状態で機器を注意して持ち上げ、輸送用カートンの中に下ろします。

8. カートン内の上部にダンボール・トレイを置き、前後の緩衝材の上に載るまで下に押し込みます。

注： 梱包の完全性と製品の安全を保証するために、梱包内にアクセサリが含まれているかどうかには関係
なくトレイをセットする必要があります。

9. アクセサリを輸送する場合は、トレイの中にアクセサリを配置します。

10.輸送用カートンを閉じてテープで止めます。

11.機器を配送先に輸送するために必要な、輸送用の適切な書類を添付します。
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